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Welkom

Welkom in de wereld van de digitale draadloze communicatie van 
Motorola. De multimedia handset Motorola A1000 is een 
uitstekende keuze. Deze handleiding beschrijft de vele 
mogelijkheden van uw A1000 multimedia handset.
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2 - Welkom

www.motorola.com 

MOTOROLA en het logo van de gestileerde M zijn gedeponeerde 
handelsmerken bij het US Patent & Trademark Office. Alle andere 
product- of servicenamen zijn het eigendom van hun respectieve 
eigenaren. De Bluetooth-handelsmerken zijn eigendom van hun 
eigenaar en worden door Motorola, Inc. onder licentie gebruikt. 
© Motorola, Inc. 2004. 
Auteursrechtinformatie met betrekking tot de software
De Motorola-producten die in deze handleiding worden 
beschreven, kunnen auteursrechtelijk beschermde software van 
Motorola en andere fabrikanten bevatten, die in de 
halfgeleidergeheugens of op andere media is opgeslagen. Wetten 
in de Verenigde Staten en andere landen bepalen dat bepaalde 
exclusieve rechten voor software waarop auteursrecht rust, zijn 
voorbehouden aan Motorola en andere softwareleveranciers, zoals 
de exclusieve rechten om de software waarop auteursrecht rust te 
distribueren of te reproduceren. Overeenkomstig deze wetten mag 
software waarop auteursrecht rust en die aanwezig is in Motorola-
producten, op geen enkele wijze worden gewijzigd, onderworpen 
aan reverse-engineering, gedistribueerd of gereproduceerd, 
voorzover dit is toegestaan door de wet. Aan de koop van 
Motorola-producten kan geen gebruiksrecht krachtens 
auteursrechten, patenten of gepatenteerde toepassingen van 
Motorola of enige andere softwareleverancier worden ontleend, 
direct noch indirect, noch door juridische uitsluiting of anderszins, 
behalve het normale, niet-exclusieve recht waarvoor geen 
vergoeding verschuldigd is, op gebruik dat voortvloeit uit de 
uitvoering van de wet bij de verkoop van een product.
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De specificaties en functies van producten kunnen zonder 
voorafgaande kennisgeving worden gewijzigd, maar wij trachten 
steeds om de gebruikershandleidingen regelmatig aan te passen 
aan eventuele veranderingen in de productfunctionaliteit. Mocht 
zich echter het onwaarschijnlijke geval voordoen, dat uw versie van 
de handleiding niet de volledige kernfunctionaliteit van het product 
beschrijft, dan stellen wij het op prijs als u ons hiervan op de hoogte 
stelt. U kunt de meest recente versies van onze handleidingen ook 
vinden in het klantengedeelte van de Motorola-website op http://
www.motorola.com.
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Veiligheids- en algemene informatie

Belangrijke informatie over veilig en efficiënt gebruik. Lees 
deze informatie voordat u uw telefoon gebruikt.
Deze informatie vervangt de algemene veiligheidsinformatie vervat 
in gebruikersgidsen die voor 1 december 2002 zijn gepubliceerd. 
Blootstelling aan energie van radiofrequentie (RF) 
energie
Uw telefoon bevat een zender en ontvanger. Wanneer de telefoon 
is ingeschakeld (AAN) ontvangt en zendt deze radiofrequentie (RF) 
energie. Wanneer u met uw telefoon communiceert, dan bepaalt 
het systeem dat uw gesprek verwerkt het vermogen waarmee uw 
telefoon uitzendt. 
Uw Motorola -telefoon is ontworpen om te voldoen aan de 
(veiligheids)normen en wetgeving in uw land inzake blootstelling 
van mensen aan RF energie.
Voorzorgsmaatregelen bij gebruik
Voor optimale werking en om er zeker van te zijn dat de 
blootstelling van mensen aan RF energie binnen de richtlijnen valt, 
dient u te allen tijde de volgende instructies te volgen.
Gebruik van externe antennes
Gebruik alleen de bijgeleverde of een door Motorola goedgekeurde 
vervangende antenne. Niet voor het apparaat bestemde of niet 
tevoren goedgekeurde antennes, wijzigingen of hulpstukken 
zouden de telefoon kunnen beschadigen.
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Houd een externe antenne NIET vast wanneer de telefoon "IN 
GEBRUIK" is. Het vasthouden van de antenne beïnvloedt de 
gesprekskwaliteit nadelig en kan ertoe bijdragen dat de telefoon 
meer vermogen gebruikt dan nodig is. Daarnaast kan toepassing 
van niet-toegestane antennes leiden tot niet-naleving van de 
plaatselijke, in de regelgeving van uw land vastgestelde eisen.
Telefoongebruik
Tijdens het voeren van een telefoongesprek dient u uw telefoon op 
dezelfde manier vast te houden als een vaste telefoon.
Dragen op het lichaam
Indien u tijdens het zenden uw telefoon op het lichaam draagt, 
plaats de telefoon dan altijd in een door Motorola goedgekeurde 
klip, houder, holster of etui. Dit is nodig om de regels inzake 
blootstelling aan RF energie na te leven. Het gebruik van 
accessoires die niet door Motorola zijn bijgeleverd of goedgekeurd 
kan meebrengen dat de maximaal toegestane blootstelling wordt 
overschreden. Indien u geen van de voorgeschreven accessoires 
op het lichaam draagt, en de telefoon niet in de normale 
gebruikerspositie gebruikt, zorg er dan voor dat de telefoon en de 
antenne tijdens het zenden tenminste 2,5 cm van uw lichaam is 
verwijderd.
Gebruik van de dataopties
Bij toepassing van de dataopties op uw telefoon, dient u - ongeacht 
of daarbij wel of niet een bijbehorende kabel wordt gebruikt - uw 
telefoon, alsmede de antenne daarvan, ten minste 2,5 cm van uw 
lichaam verwijderd te houden.
Goedgekeurde accessoires
Het gebruik van niet door Motorola goedgekeurde accessoires, met 
inbegrip van maar niet beperkt tot batterijen en antennes, kan ertoe 
leiden dat met uw telefoon de richtlijnen betreffende de blootstelling 
aan RF energie worden overschreden. Raadpleeg onze website 
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www.motorola.com voor een lijst met door Motorola goedgekeurde 
accessoires.
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RF Energie storing / compatibiliteit
Belangrijk: Nagenoeg elk elektronisch apparaat is onderhevig aan 
RF energie storing van externe bronnen als het niet afdoende is 
beschermd, ontworpen of op andere wijze is geconfigureerd voor 
RF energie compatibiliteit. In sommige gevallen kan uw telefoon 
storing veroorzaken.
Gebouwen
Schakel uw telefoon uit in gebouwen waar u wordt verzocht dit te 
doen. Deze gebouwen kunnen ziekenhuizen en zorgvoorzieningen 
behelzen welke uitgerust kunnen zijn met apparatuur die gevoelig 
is voor interferentie. 
Vliegtuigen
Schakel uw telefoon uit, wanneer u dit aan boord van een vliegtuig 
wordt opgedragen. Ieder gebruik van een telefoon moet in 
overeenstemming zijn met de aan boord toepasselijke regels.
Medische apparaten
Pacemakers
De producenten van pacemakers adviseren dat er minimaal 15 cm 
afstand wordt gehouden tussen een draadloze handtelefoon en 
een pacemaker. 
Personen met pacemakers dienen het volgende te doen: 

� Houd de telefoon ALTIJD méér dan 15 cm van de pacemaker, 
wanneer de telefoon is ingeschakeld.

� Draag de telefoon niet in een borstzak. 
� Gebruik het oor aan de tegenovergestelde kant van de 

pacemaker om de kans op storing zoveel mogelijk te 
beperken. 

� Schakel de telefoon onmiddellijk uit, als u ook maar denkt dat 
storing plaatsvindt.
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Gehoorapparaten
Sommige digitale draadloze telefoons kunnen bij sommige 
gehoorapparaten storing veroorzaken of ondervinden. Mocht een 
dergelijke storing optreden, dan kunt u wellicht contact op nemen 
met de fabrikant van uw gehoorapparaat om alternatieven te 
bespreken.
Andere medische apparaten
Indien u enig ander medisch apparaat of hulpstuk gebruikt, neem 
dan contact op met de fabrikant van uw apparaat om te bepalen of 
het voldoende is beschermd tegen RF energie. Uw arts zou u 
wellicht kunnen helpen bij het verkrijgen van deze informatie.
Gebruik in voertuigen
Kijk de wetten en regels na over het gebruik van telefoons in uw 
voertuig. Volg de regels altijd op.
Wanneer u uw telefoon in een voertuig gebruikt, verzoeken wij u 
het volgende te doen: 

� Schenk al uw aandacht aan het rijden en de weg.
� Gebruik bediening zonder handen (hands-free).
� Indien de rijomstandigheden dit toelaten, verlaat de weg en 

parkeer uw auto alvorens een telefoongesprek te gaan 
voeren. 

Operationele waarschuwingen
Voor voertuigen met een airbag
Plaats de telefoon niet bovenop een airbag of in de ruimte, die een 
airbag in opgeblazen toestand inneemt. Airbags blazen met 
enorme kracht op. Indien de telefoon in de ruimte is geplaatst waar 
een airbag automatisch wordt opgeblazen en de airbag blaast op, 
dan kan de telefoon met enorme kracht losschieten en ernstig 
letsel veroorzaken aan de inzittenden van het voertuig.
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Mogelijk explosieve atmosfeer 
Schakel uw telefoon uit vóór u een gebied ingaat, waar mogelijk 
explosiegevaar heerst, behalve als het apparaat speciaal geschikt 
is voor het gebruik in dergelijke gebieden en als "intrinsiek veilig" 
voor dergelijke gebieden is aangemerkt. Verwijder, installeer en 
laad geen batterijen in dergelijke gebieden. Vonken kunnen een 
ontploffing of brand veroorzaken die lichamelijk letsel en zelfs de 
dood tot gevolg kan hebben. 
Belangrijk: De gebieden, waaraan hierboven wordt gerefereerd, 
zijn onder andere gebieden waar brandstof wordt gepompt, zoals 
onderdeks op schepen, gebieden voor het overpompen of de 
opslag van brandstof of chemicaliën, gebieden waar de lucht 
chemicaliën bevat of deeltjes zoals graan, stof of metaalpoeders. 
Voor gebieden met mogelijke explosieve atmosferen wordt u veelal 
maar niet altijd gewaarschuwd door middel van borden. 
Springladingen en gebieden waar ontploffingen 
plaatsvinden 
Schakel uw telefoon uit wanneer u in de buurt bent van elektrische 
springladingen, in een gebied waar ontploffingen worden 
uitgevoerd, of in gebieden waar is voorgeschreven: "Elektronische 
apparaten uitschakelen". Volg alle tekens en voorschriften op.
Batterijen
Batterijen kunnen zaakschade en/of lichamelijk letsel veroorzaken 
zoals brandwonden, indien een geleidend materiaal, zoals 
sieraden, sleutels of kralenkettingen blootgestelde apparatuur 
aanraakt. Het geleidende materiaal kan een elektrische 
stroomkring vervolmaken (kortsluiten) en erg heet worden. Wees 
voorzichtig bij het hanteren van een geladen batterij, speciaal 
wanneer deze in een binnenzak, tas of andere houder wordt 
geplaatst met een of meer metalen voorwerpen. Gebruik alleen 
originele Motorola batterijen en opladers.
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Op uw batterij of telefoon kunnen de volgende symbolen met de 
volgende betekenis voorkomen: 

Aanvallen/black-outs
Sommige mensen kunnen bij blootstelling aan knipperend licht 
vatbaar voor epileptische aanvallen of black-outs zijn, bijvoorbeeld 
bij televisiekijken of het doen van videospelletjes. Deze aanvallen 
of black-outs kunnen zich óók voordoen als dat nog nooit eerder 
het geval is geweest.
Als u al eens een aanval of black-out heeft gehad, of als dat in uw 
familie voorkomt, overlegt u dan met uw arts alvorens op uw 
telefoon videospelletjes te spelen of een knipperlichtoptie op uw 
telefoon te programmeren. (De knipperlichtoptie is niet op alle 
producten voorhanden).

Symbool Betekenis
Er volgt belangrijke veiligheidsinformatie.

U dient zich niet van uw batterij of telefoon te 
ontdoen door deze in het vuur te werpen.
Uw batterij of telefoon dient eventueel conform de 
plaatselijke wetgeving te worden gerecycled. 
Neem voor nadere informatie contact met de 
lokale regelgevende instanties op.
U dient uw batterij of telefoon niet samen met het 
vuilnis weg te gooien.
Uw telefoon bevat een interne lithium-ionbatterij.LiIon BATT
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Ouders dienen goed toe te zien op het gebruik door hun kinderen 
van videospelletjes of andere opties waarbij er knipperlichten op de 

telefoon komen. Het gebruik dient direct gestaakt te 
worden en er dient een arts te worden geraadpleegd, 
mocht zich een van de volgende symptomen voordoen: 
stuiptrekkingen, oog- of spiertrillingen, bewusteloosheid, 
onwillekeurige bewegingen en/of desoriëntatie.

Teneinde de kans hierop te beperken, dient u de volgende 
voorzorgsmaatregelen te nemen: 

� Speel niet met een knipperlichtoptie c.q. maak daarvan geen 
gebruik als u moe bent of behoefte heeft aan slaap.

� Neem ieder uur minimaal 15 minuten pauze.
� Speel alleen in een goed verlichte ruimte.
� Houdt het scherm tijdens het spelen zo ver mogelijk van u af.

RSI
Als u op uw telefoon spelletjes speelt, dan kunt u incidenteel last 
krijgen van uw handen, armen, schouders, nek en/of andere 
lichaamsdelen. Teneinde problemen als peesontstekingen, 
carpaaltunnelsyndroom en/of andere aandoeningen van het 
bewegingsapparaat te voorkomen, dient u deze aanwijzingen op te 
volgen: 

� Neem ieder uur dat u spelletjes speelt, minimaal 15 minuten 
pauze.

� Als uw handen, polsen en/of armen tijdens het spelen moe 
worden of zeer gaan doen, stop dan, en neem een paar uur 
rust alvorens verder te spelen.

� Als de pijn in uw handen, polsen en/of armen tijdens of na het 
spelen aanhoudt, stop er dan mee en ga naar een dokter.
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EU-conformiteitsverklaring
Hierbij verklaart Motorola dat dit product overeenstemt met

� de essentiële vereisten en andere relevante bepalingen van 
richtlijn 1999/5/EG

� alle andere relevante EU-richtlijnen

Bovenstaande is een voorbeeld van een typisch 
productkeuringsnummer.
U kunt de verklaring van overeenstemming van uw product met 
richtlijn 1999/5/EG (de richtlijn voor radio-apparatuur en 
telecommunicatie-eindapparatuur) bekijken op www.motorola.com/
rtte - voor de gewenste conformiteitsverklaring voert u het 
productkeuringsnummer van het etiket op het product in het vakje 
"Search" op de webpagina in.

 

0168
Type: MC2-41H14

IMEI: 350034/40/394721/9

Product-
keurings-
nummer 
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Aan de slag

Wat zit er in de doos?
Met uw handset wordt het volgende meegeleverd:

� Oplaadbare batterij
� Snellader en regionale adapter
� Bureau laadstation
� Stylus
� Stereo headset met verzenden/einde-toets
� cd-rom met pc sync-software, downloadbare media-

bestanden, utilities, en verschillende toepassingen
� USB-datakabel
� Verwisselbare geheugenkaart met SD/MMC-adapter (zie 

opmerking)
� Beschermende draagtas (zie opmerking)
� Gebruikershandleiding

Opmerking: De items in de doos kunnen verschillen per land. 
Neem voor meer informatie contact op met uw serviceprovider.
U kunt uw handset optimaliseren voor maximale prestaties en 
draagbaarheid. Voor de aanschaf Voor de aanschaf van Motorola 
Original accessories en aanvullende informatie, bezoek:
www.hellomoto.com
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Over deze handleiding
Deze handleiding beschrijft de basismogelijkheden van uw 
multimedia-handset.

Optionele functies

Optionele accessoires
Met dit label wordt een functie aangegeven waarvoor een 
optionele accessoire van Motorola Original� is vereist. 

De USIM-kaart plaatsen
De USIM-kaart (Universal Subscriber Identity Module) bevat uw 
telefoonnummer, servicegegevens en het geheugen voor het 
telefoonboek en berichten.

Met dit label wordt een optionele functie aangeduid die 
afhankelijk is van het netwerk, de USIM-kaart of het 
abonnement en die niet door alle serviceproviders in 
alle geografische regio's wordt aangeboden. Neem 
voor meer informatie contact op met uw 
serviceprovider.
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Let op: Buig of kras de USIM-kaart niet. Stel de USIM-kaart niet 
bloot aan statische elektriciteit, water of vuil.

Actie 
1 Druk de 

ontgrendeling in en 
schuif de achterkant 
naar beneden om 
deze te verwijderen.

2 Schuif het klepje van 
de USIM-kaart naar 
boven en hef het op 
om het te openen.

3 Plaats de USIM-kaart 
in de houder (met de 
goudcontacten naar 
beneden, het schuine 
hoekje naar rechts).
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De geheugenkaartkaart plaatsen
Op de geheugenkaart kunnen mediabestanden opgeslagen 
worden, zoals geluidsbestanden, foto's en videoclips.

4 Sluit het klepje van 
de USIM-kaart, en 
schuif het naar 
benden om het te 
vergrendelen, zoals 
getoond op het klepje 
en op de afbeelding.

Actie 
1 Verwijder zonodig de achterkant van de telefoon.
2 Schuif het klepje van 

de geheugenkaart 
naar links en hef het 
op zoals op de 
afbeelding.

3 Plaats de geheugenkaart in de houder (met de 
goudcontacten naar beneden, de nokjes naar rechts).

4 Sluit het klepje van de geheugenkaart en schuif het naar 
beneden om het te vergrendelen.

Actie 
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Batterijgebruik
De prestaties van de batterij zijn afhankelijk van allerlei factoren, 
zoals de configuratie van het draadloze netwerk, de signaalsterkte, 
de temperatuur waarbij u de handset gebruikt, de functies en/of 
instellingen die u selecteert en gebruikt, accessoires die u op de 
handset hebt aangesloten, en de mate waarin u de spraak- en 
gegevenstoepassingen en overige toepassingen gebruikt.
Let op: om letsel en brandwonden te voorkomen, moet u de polen 
van de batterij niet met een metalen voorwerp aanraken en geen 
kortsluiting veroorzaken. 
U kunt de prestaties van de batterij als volgt optimaliseren:

� Gebruik altijd Motorola Original-batterijen en -batterijladers. 
De garantie van de handset dekt geen schade die ontstaat 
door het gebruik van batterijen en/of batterijladers die niet van 
Motorola zijn.

� Het opladen van nieuwe batterijen of batterijen die lange tijd 
zijn opgeslagen, kan soms langer duren.

� Zorg ervoor dat de batterij ongeveer op kamertemperatuur is 
als u deze oplaadt. 

� Stel batterijen niet bloot aan temperaturen beneden -10°C of 
boven 45°C. Neem de handset altijd mee als u uw auto 
verlaat.

� Als u van plan bent om een batterij een tijdje niet te gebruiken, 
bewaart u deze op een koele, donkere plaats, bijvoorbeeld in 
de koelkast. 

� Na verloop van tijd zal de batterij langzaam maar zeker 
verslijten en kost het steeds meer tijd om de batterij op te 
laden. Dit is normaal. Als u de batterij geregeld oplaadt en 
merkt dat de spreektijd die u hebt, korter wordt of dat het 
langer duurt voordat de batterij is opgeladen, is het 
waarschijnlijk tijd om een nieuwe batterij aan te schaffen.
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De oplaadbare batterijen die de stroom leveren voor dit 
product, moeten als klein chemisch afval worden 
behandeld en kunnen mogelijk worden gerecycled. Kijk 
op het label van de batterij om na te gaan welk type 

batterij u gebruikt. Neem contact op met een lokaal recyclingbedrijf 
of de gemeente als u wilt weten wat u moet doen met uw 
afgedankte batterijen.
Waarschuwing: Gooi batterijen nooit in het vuur, want ze kunnen 
exploderen

De batterij plaatsen
Gebruik alleen Motorola Original� -batterijen en 
-accessoires. Bewaar batterijen in hun verpakking als ze 
niet worden gebruikt.

Actie 
1 Haal de batterij uit de verpakking
2 Verwijder de achterkant indien aanwezig.
3 Duw de 

contactpunten van de 
batterij tegen de 
contactpunten van de 
telefoon en druk de 
batterij naar 
beneden.
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De batterijen laden met de snellader
Nieuwe batterijen zijn bij levering gedeeltelijk opgeladen. Voor u uw 
handset kunt gaan gebruiken, moet u de batterij plaatsen en 
opladen, zoals beschreven in de navolgende instructies. Sommige 
batterijen functioneren pas optimaal na verschillende keren volledig 
te zijn ontladen/opgeladen. 

4 Plaats de achterkant 
terug en klik deze vast 
zoals is weergegeven op 
de afbeelding.

Actie 
1 Plug de lader in met 

de ontgrendeling 
naar boven.

2 Steek de stekker in een stopcontact. Terwijl de batterij 
oplaadt, Charging Battery en het bereikte laadpeil (Very Low om 
High) zichtbaar op het scherm.

3 Zodra Charging Complete zichtbaar wordt, kunt u de 
ontgrendeling indrukken en de lader verwijderen.

Actie 
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De batterij laden met de bureaulader

Uw handset in- en 
uitschakelen
Nadat u de handset inschakelde, 
wordt na de startsequentie uw 
persoonlijke homepagina zichtbaar 
(zie pagina 40).

Uw handset voor de eerste keer inschakelen
Als u uw handset voor de eerste keer gaat inschakelen moet u:

� De A1000 Desktop Suite van de meegeleverde cd installeren. 
Zie pagina 70 voor het instellen en de installatieprocedures.

� Selecteer de hoofdtaal en de secondaire talen 
� Kalibreer het scherm zodat de Touchscreen-functie accuraat 

werkt (zie pagina 67).
� Datum en tijd instellen (zie pagina 86).

Actie 
1 Plug de snellader met de nok omhoog 

in de achterzijde van het laadstation.
2 Steek de stekker in een stopcontact.
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Bellen en beantwoorden van gesprekken
Om te kunnen bellen en gesprekken te kunnen beantwoorden, 
moet uw handset:

� ingeschakeld zijn
� voorzien zijn van een USIM-kaart
� over een netwerkverbinding met voldoende signaalsterkte 

beschikken.

Een oproep verzenden
Actie 

1 DrukA of tik op .
2 Selecteer een voice- of videogesprek door te tikken op:

 voice-gesprek

 video-gesprek

3 Gebruik de stylus om het nummer in te tikken.
4 Druk op B. 
5 Druk op a om de speaker tijdens het gesprek in te 

schakelen (zie pagina 43).
Opmerking: De speaker kan alleen tijdens een actief gesrek 
ingeschakeld worden.

6 Om het gesprek te beëindigen druk A.
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Een oproep beantwoorden
Indien u een binnenkomende oproep ontvangt, belt of trilt de 
handset (tenzij het profiel op Stil staat).

Actie 
1 Druk B of tik op Answer.
2 Om het gesprek te beëindigen druk A.
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Uw handset gebruiken

Zie pagina 1 voor een afbeelding van de handset met de 
belangrijkste functies.

Scherm handset

Application 
Selector-balk

Bevat zes pictogrammen, die een gemakkelijke 
toegang bieden tot vaak gebruikte 
toepassingen.

Menubalk Toont menu's voor de actieve toepassing.
Application Toont de geopende toepassing.
Knoppenbalk Toont de knoppen die u in de actieve toepassing 

kunt selecteren.
Statusbalk Toont statusinformatie over de handset.

Ruimte 
Application

Application 
Selector-balk

Menubalk

Knoppenbalk

Statusbalk
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Het touchscreen gebruiken
De stylus past in een opening aan de 
zijkant van de handset. Tik met behulp 
van de stylus één keer op een 
pictogram, een tekst of een knop op het 
scherm om een item te selecteren en te 
openen.

De navigatietoets gebruiken
U kunt de navigatietoets omhoog, 
naar beneden, naar links of naar 
rechts drukken om een item te 
markeren. Druk op de 
navigatietoets om het 
gemarkeerde item te selecteren.
Opmerking: Deze handleiding beschrijft hoe u het touchscreen 
gebruikt om de functies te bedienen. In de meeste gevallen is het 
niet nodig de gelijkwaardige navigatietoets te gebruiken

Werken met de browser-toets
De browser-toets (L) biedt toegang 
tot unieke mogelijkheden van uw 
serviceprovider.

� Druk om de browser te openen.
� Houd 3 seconden ingedrukt om te 

gaan naar My Shortcut.
Opmerking: De standaard shortcut is Home. Om deze shortcut te 
wijzigen zie pagina 68.
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Werken met de speltoetsen

Speltoets A en speltoets B
Deze toetsen worden gebruikt om spelletjes te spelen op uw 
handset. De functie van de toetsen verschilt per spel.
Tip: U kunt drukken op speltoets A (F) om het meest linkse menu 
in de menubalk te openen. Druk nogmaals op F om het menu te 
sluiten.

Toepassingen openen
Uw handset beschikt over veel ingebouwde toepassingen voor 
communicatie, uw persoonlijke organisatie en ontspanning. Elke 
toepassing heeft een eigen pictogram.
U kunt een toepassing op de volgende manieren openen:

� Selecteer een pictogram in de Application Selector-balk.

� Selecteer . De Application Launcher wordt zichtbaar en 
toont de pictogrammen van alle toepassingen op uw handset. 
Kies de toepssaing die u wilt openen.

Opmerking: U hoeft een toepassing niet op te slaan en te sluiten 
voor u een andere opent. Veranderingen of ingevoerde informatie 
worden automatisch opgeslagen.
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De volgende pictogrammen openen de toepassingen van de 
handset:

Browser
(zie pagina 95)

Notities
(zie pagina 86)

Calculator
(zie pagina 90)

Telefoontoepassing
(zie pagina 42)

Agenda
(zie pagina 79)

Picsel Viewer
(zie pagina 74)

Camera
(zie pagina 104)

Foto's
(zie pagina 113)

Telefoonboek
(zie pagina 58)

SimApps
(zie pagina 116)

Control Panel
(zie pagina 66)

SyncML
(zie pagina 73)

Desktop Suite
(zie pagina 70)

Tijd
(zie pagina 86)

Home
(zie pagina 40)

To do
(zie pagina 82)

Messaging
(zie pagina 50)

Video
(zie pagina 108)

Muziek
(zie pagina 98)

Voice-opname
(zie pagina 90)
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Mappen
Veel toepassingen hebben 
verschillende mappen. De actieve 
foldernaam wordt zichtbaar aan de 
rechterzijde van de menubalk 
bovenaan het scherm. 
U kunt mappen gebruiken om uw 
gegevens te organiseren. U kunt 
bijvoorbeeld afzonderlijke mappen 
aanmaken voor zakelijke en 
persoonlijke gegevens.

Overschakelen tussen 
mappen
Tik op de naam van de huidige map 
en selecteer een map in de lijst. Om 
alle gegevens in alle mappen te bekijken, selecteert u All.

Nieuwe gegevens in een map opslaan

Gegevens naar een andere map verplaatsen

Actie 
1 Selecteer een map binnen een toepassing.
2 Maak een nieuw gegeven aan. Het gegeven wordt 

automatisch aan de map toegewezen.

Actie 
1 Open het gegeven.
2 Selecteer een andere map. Het gegeven wordt automatisch 

naar de andere map verplaatst.
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Mappen toevoegen, van naam veranderen en 
verwijderen

Statusindicatoren
De statusbalk onderaan het scherm heeft de volgende 
statusindicatoren:

Tijd - Geeft de tijd aan. Tik op de klok om de datum te zien.
Toetsenbord Launcher - Tik hier om het toetsenbord zichtbaar te 
maken. (Het toetsenbord wordt alleen zichtbaar indien de cursor in 
een tekstinvoerveld staat.)
Waarschuwingsprofiel - Toont het actieve waarschuwingsprofiel:

Audio: Trillen:  Stil: 
Het waarschuwingsprofiel geeft aan hoe de handset u waarschuwt 
bij een inkomend gesprek of bericht. 

Actie 
1 Tik op de huidige map, en selecteer Edit folders.
2 Om een nieuwe map toe te voegen, tik Add.

Om de naam van een map te veranderen, tik Rename.
Om de map te verwijderen, tik Delete.

Toetsenbord 
Launcher

HandsetTijd 
Waarschu-
wingsprofiel

Bericht

Batterij-
toestand

Signaalsterkte

Netwerk
Bluetooth-
status

Locatieprofiel
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Om het waarschuwingsprofiel te wijzigen tikt u op de indicator en 
kiest u een nieuwe instelling.
Bluetooth-status - Geeft de Bluetooth-status aan:

Aan: Wit Uit: Grijs
Tip: U kunt op het pictogram tikken, en daarna kiezen om 
Bluetooth in of uit te schakelen (zie pagina 70).
Locatieprofiel - Indiceert of de GPS (Global Positioning System) 
location-dienst uit staat, standby of bezig is (en locatie-informatie 
zoekt). De kleur geeft het locatieprofiel aan:

Uit: Grijs Standby: Wit Bezig: Groen
Om de Locatie-service in- of uit te schakelen, tikt u op de indicator, 
om daarna de gewenste instelling te selecteren. De locatie-service 
stelt u in staat uw huidige locatie te volgen op het scherm van de 
handset.
Handset - Geeft de status van een actief gesprek: 

Verbonden: Geluid uit: 
Indien u niet in gesprek bent:

Voicemail wacht: 

Videomail wacht:  
Opmerking: Videomail wordt mogelijk niet door alle 
serviceproviders in alle geografische gebieden aangeboden. 

Bericht - Geeft aan dat u een nieuw bericht heeft ontvangen, 
samen met het type van het bericht:

E-mail: Tekstbericht: Multimedia-bericht: 
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Als het telefoonnummer van de afzender van een multimedia- of 
tekstbericht in uw telefoonboek voorkomt, wordt de indicator wit. 
Als het telefoonnummer niet in uw telefoonboek voorkomt word de 
indicator amberkleurig. Als er meerdere soorten nieuwe berichten 
beschikbaar zijn, wordt  zichtbaar.
Netwerk - Geeft het type netwerkverbinding: 

Geen service:  (grijs)

Alarmnummers:  (rood)

Aangesloten op het GSM-thuisnetwerk:  (één groen 
segment)

Aangesloten op het GPRS-thuisnetwerk:  (twee groene 
segmenten)

Aangesloten op het thuisnetwerk met video-dekking:  (drie 
groene segmenten)

Roaming naar een ander type dan het thuisnetwerk:  (drie 
amber segmenten)

Vliegtuigmodus (netwerkverbinding uitgeschakeld): 
Om het vliegtuigprofiel in- of uit te schakelen, tikt u op de indicator, 
om daarna de gewenste instelling te selecteren (zie pagina 49).
Signaalsterkte - Geeft de signaalsterkte van het netwerk. Hoe 
meer streepjes, hoe sterker het signaal van het netwerk.
Batterijsterkte - Geeft aan hoe ver de batterij is opgeladen. Hoe 
meer streepjes zichtbaar zijn, hoe groter de beschikbare lading. De 
indicator is amber wanneer de handset veel energie verbruikt, 
zoals tijdens een videogesprek. Als  zichtbaar is, wordt de 
batterij opgeladen en indien  zichtbaar is, kan de batterij niet 
worden geladen.
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Tekst invoeren
U kunt tekst invoeren door middel van handschriftherkenning of 
met het virtuele toetsenbord.

Handschriftherkenning
Opmerking: U kunt het handschiftvlak alleen gebruiken indien de 
cursor zich in een tekstinvoerveld bevindt.
U kunt de stylus gebruiken als pen om letters, cijfers en leestekens 
in te voeren. Om met de stylus te schrijven, tikt u op  in de 
statusbalk. Het handschriftvak of het toetsenbord worden zichtbaar 
(afhankelijk van welk van de twee u het laatst gebruikte). Indien het 
toetsenbord zichtbaar is, tikt u op  en daarna Handwriting in het 
popup-menu.

Aan de linkerzijde van het handschriftvak kunt u selecteren of u 
letters, cijfers of speciale tekens wilt invoeren. Gebruik daarna de 
stylus om te schrijven in één van beide schrijfvakken. Wissel voor 
de beste prestaties af tussen de schrijfvakken zodat de 
handschriftherkenning kan plaatsvinden terwijl u in het andere vak 
schrijft. 
Om speciale tekens, spaties, of een nieuwe regel in te voeren, tikt u 
op de knoppen onder de schrijfvakken.

Schrijfvakken

Tik hier om letters 
te schrijven

Tik hier om cijfers 
te schrijven

Tik hierom speciale 
tekens te schrijven
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Virtueel toetsenbord
Opmerking: U kunt het handschiftvlak alleen gebruiken indien de 
cursor zich in een tekstinvoerveld bevindt.
Om het toetsenbord op het scherm te gebruiken om tekst in te 
tikken, tikt u op  in de statusbalk. Het handschriftvak of het 
toetsenbord worden zichtbaar (afhankelijk van welk van de twee u 
het laatst gebruikte). Indien het handschriftvak zichtbaar is, tikt u op 

, en daarna Roman Keyboard in het popup-menu.
Om te typen tikt u met de stylus op de toetsen van het virtuele 
toetsenbord.

AGPS locatie-informatie
Uw handset kan gebruik maken van AGPS (Assisted Global 
Positioning Service) om aan het netwerk door te geven waar u zich 
bevindt. 
Om de instellingen van uw Locatieprofiel te veranderen, tikt u op 
het pictogram Locatieprofiel ( ) in de statusbalk van uw handset 
(pagina 35).
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Beperkingen van AGPS
Soms zijn er geen goede signalen van meerdere satellieten 
beschikbaar. Dit komt meestal doordat de antenne van een AGPS-
handset geen goed zicht krijgt op een stuk open lucht. In dergelijke 
omstandigheden werkt de AGPS-functie niet. Dergelijke 
omstandigheden kunnen onder andere zijn: 

� ondergronds 
� in gebouwen, treinen of andere overdekte voertuigen 
� onder metalen of betonnen daken of constructies 
� tussen hoge gebouwen of onder dichte bebossing 
� in de buurt van een krachtige zendmast voor radio of tv 
� als de AGPS-antenne bedekt is (uw hand of een voorwerp ligt 

er bijvoorbeeld op) of naar de grond wijst 
� bij extreme temperaturen, die buiten het werkbereik van de 

handset vallen
Zelfs als er in dergelijke omstandigheden locatie-informatie kan 
worden berekend, kan dit langer duren dan normaal en is het 
mogelijk dat de schatting van uw positie niet helemaal nauwkeurig 
is. De AGPS-prestaties kunnen ook door wandelen of stapvoets 
rijden aanzienlijk verslechteren. 
Zelfs als er goede signalen van meerdere satellieten beschikbaar 
zijn, geeft de AGPS-functie niet meer dan een benadering van uw 
positie, veelal binnen 45 meter, maar soms veel verder dan uw 
feitelijke locatie. 
De satellieten, gebruikt door de AGPS-mogelijkheid van uw 
telefoon worden beheerd door overheidsorganen en zijn mogelijke 
onderworpen aan veranderingen; door hen geïmplementeerd. 
Deze wijzigingen kunnen de prestaties van de AGPS-functie van 
uw handset beïnvloeden.
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Startscherm

Het startscherm toont een variëteit aan informatie. Dit kan een 
overzicht zijn van uw afspraken, berichten en persoonlijke links 
naar eigen keuze zoals nieuws, ontspanning en sport.

Het startscherm zichtbaar maken
Het startscherm wordt zichtbaar na het voltooien van 
startsequentie als u de handset inschakelt. U kunt het startscherm 
ook zichtbaar maken door te tikken op Home  in de 
Application Selector-balk.

Inhoud scherm

Informatie Snacks

Persoonlijke 
informatie

Shortcuts naar 
toepassingen

Application 
Selector-balk
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Informatie Snacks - Toont de drie laatst ontvangen 
informatieberichten (headlines). Tik op een bericht om naar een 
webpagina te gaan met meer informatie.
Persoonlijke informatie - Toont de informatie die u wilt weergeven 
in het deel Persoonlijke informatie. Afhankelijk van uw selectie, 
toont dit gedeelte het aantal nieuwe voicemails, berichten, 
afspraken en lopende actieve taken.
Shortcuts naar toepassingen - voor een snelle toegang tot uw 
favoriete toepassingen.

Het startscherm personaliseren

Opmerking: Om bijgewerkte informatie te krijgen van uw 
serviceprovider, tikt u op het tabblad Content, en daarna op Update.

Actie 
1 Ga naar het startscherm (indien het niet zichtbaar is).
2 Tik op Home > Preferences.
3 Tik op het tabblad Events.
4 Selecteer tot zes items die u wilt zien in het deel Persoonlijke 

informatie door deze aan te vinken.
Opmerking: Zodra er zes items zijn geselecteerd, zijn de 
andere items niet langer selecteerbaar. Om een selectie te 
veranderen of toe te voegen moet u een vinkje verwijderen 
voor een geselecteerd item.

5 Tik op het tabblad Applications.
6 Selecteer de drie toepassingen die u wilt weergeven in het 

gedeelte met de shortcuts naar de toepassingen, en tik op 
Done.
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Gespreksfuncties

De telefoontoepassing openen
Gebruik de telefoontoepassing om voice- en video-
telefoongesprekken te voeren. U kunt deze toepassing op de 
volgende manieren openen:

� Druk op B. De belgeschiedenis wordt geopend in de 
telefoontoepassing.

� Druk A of tik  aan in de Application Selector-balk of de 
Application Launcher. Het toetsenbord wordt zichtbaar in de 
telefoontoepassing:

Tik de 
toetsen aan 
om het 
nummer in 
te voeren

Het laatste 
cijfer wissenScherm 

Een voice- 
gesprek 
voeren

Schakelen tussen het 
toetsenbord en de 
belgeschiedenis

Een video-gesprek 
voeren
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Uw telefoonnummer weergeven
Uw telefoonnummer moet op de USIM-kaart zijn opgeslagen om 
deze functie te kunnen gebruiken. Tik op  in de Application 
Selector-balk. Tik vervolgens op Phone > My line(s). De handset toont 
uw eigen telefoonnummer(s). 

De ingebouwde Speaker 
gebruiken
Om de ingebouwde speaker tijdens 
een inkomend of lopend gesprek in te 
schakelen, drukt u opa.

Het volume aanpassen
Druk tijdens een gesprek op de 
bovenste volumetoets om het volume 
te verhogen of op de onderste om het 
volume van de luidspreker of de 
headset te verlagen. 
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Een voice-oproep verzenden

Bellen met het toetsenbord

Bellen naar nummers uit het geheugen
U kunt telefoonnummers uit het telefoonboek direct bellen (zie 
pagina 58).

Terugbellen mislukte voice-oproep
Indien een voice-oproep niet slaagt (bezet of geen gehoor), ziet u 
Call failed. Om opnieuw te kiezen tikt u op de toets Retry.

Een Video-oproep doen
U kunt videogesprekken voeren met andere telefoons die over 
video-mogelijkheden beschikken.

Actie 

1 Tik op  in de Application Selector-balk of de Application 
Launcher.

2 Selecteer een voice-gesprek door op te tikken.

3 Voer het telefoonnummer in met het toetsenbord.

4 Tik op  om het laatste cijfer te wissen. Blijf  
aanraken om meer of alle cijfers te wissen.

5 Tik twee keer op of druk B om te bellen.
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Een video-oproep doen
U kunt een video-oproep doen door het nummer in te voeren met 
het toetsenbord.
Snelkoppeling: U kunt direct video-oproepen doen naar in het 
telefoonboek opgeslagen nummers.

Actie 

1 Tik op  in de Application Selector-balk of de Application 
Launcher.

2 Richt de lens van de voorste camera. (zie pagina 105).
Opmerking: De speaker wordt automatisch ingeschakeld 
tijdens videogesprekken.

3 Voer het telefoonnummer in met het toetsenbord.

Tik op  om het laatste cijfer te wissen. Blijf  
aanraken om meer of alle cijfers te wissen.
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Een video-oproep versturen naar een computer
Om een video-oproep te doen naar een computer, kunt u 
gebruik maken van:

� Belgeschiedenis - Om naar een computer uit uw 
belgeschiedenis te bellen, tikt u op het e-mailadres 
waarnaar u wilt bellen.

� Telefoonboek - Om een telefoonnummer uit het telefoonboek 
te bellen, zie pagina 58.

� Embedded e-mailadres - Om te bellen naar het e-mailadres 
van een computer, tikt u op het adres in een e-mail, een 
tekstbericht, een multimediabericht, of een HTML-pagina.

4 Tik op .
Zodra u verbinding heeft ziet u het ontvangen beeld in uw 
scherm en het beeld van uw eigen camera onderaan.

Actie 

Tik om het beeld te 
roteren

Uw eigen beeld
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Een alarmnummer bellen
De serviceprovider programmeert een of meer alarmnummers in, 
bijvoorbeeld 112, die u altijd kunt bellen, zelfs wanneer de telefoon 
is vergrendeld of de USIM-kaart niet is geplaatst.

De serviceprovider kan extra alarmnummers op de 
USIM-kaart programmeren. De USIM-kaart moet echter 
in de telefoon zijn geplaatst om de nummers die erop 
zijn opgeslagen te kunnen gebruiken. Vraag uw 
serviceprovider om aanvullende informatie.

Opmerking: alarmnummers kunnen verschillen per land. De op uw 
handset geprogrammeerde alarmnummers werken mogelijk niet op 
alle locaties, en soms kunnen alarmnummers niet worden bereikt 
door netwerk-, omgevings- of storingsfactoren.

AGPS gebruiken als u een alarmnummer belt 
Als u een alarmnummer belt, kan de functie Assisted-Global 
Positioning System (AGPS) uw positie bij benadering berekenen 
en medewerkers van alarmdiensten helpen u te vinden. 
Opmerkingen: 

� Deze functie werkt alleen als de alarmcentrale 
locatie-informatie kan ontvangen en verwerken. U kunt bij de 
lokale overheid informeren of de plaatselijke alarmcentrale 
AGPS-locatie-informatie kan ontvangen.

� De AGPS-functie bij het bellen van alarmnummers werkt 
alleen als deze service is ingeschakeld (zie pagina 35).

U kunt het best op een plaats gaan staan waar de antenne van uw 
handset ononderbroken zicht heeft op de lucht. Zo kan uw telefoon 
toegang krijgen tot AGPS-satellietsignalen. Zelfs onder goede 
omstandigheden kan het nog 30 seconden of langer duren voordat 
uw positie bij benadering is bepaald. Als de toegang tot de 
satellietsignalen beperkt is, neemt de tijd om u te traceren toe en 
de nauwkeurigheid van de resultaten af.
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Als uw handset niet goed toegang kan krijgen tot AGPS-
satellietsignalen, krijgt de alarmcentrale automatisch de locatie van 
de dichtstbijzijnde zendmast voor mobiel verkeer door. 
Doordat de AGPS-functie beperkingen heeft, is het van belang dat 
u de alarmcentrale uw positie zo nauwkeurig mogelijk doorgeeft, 
zoals u dat ook zou doen als u niet over de AGPS-functie zou 
beschikken. Blijf net zo lang aan de telefoon als de alarmcentrale u 
aanraadt.

Het gesprek beginnen

Gesprekken beantwoorden
Indien u een binnenkomende voice- of video-oproep ontvangt, belt 
of trilt de handset (tenzij het profiel op Stil staat).

Opmerkingen: Bij video-gesprekken is het pictogram  
zichtbaar.

Actie 
1 Gebruik het toetsenbord om het alarmnummer in te voeren.
2 Druk B om het alarmnummer te bellen.

Actie 
Druk B of tik op Answer om het gesprek aan te nemen.
Opmerking: Druka om de speaker in te schakelen.
Indien u het gesprek niet wilt aannemen, drukA of tik op Busy.
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Overschakelen naar de vliegtuigmodus
Indien u gebruik wilt maken van de organiser- en 
ontspanningsmgelijkheden van uw handset in een situatie waarin 
het gebruik van de telefoon niet is toegestaan (zoals aan boord van 
een vliegtuig) schakelt u de handset in vliegtuigmodus. 
In de vliegtuigmodus kunt u geen verbinding maken met het 
netwerk om te telefoneren of berichten te verzenden. Verder zijn 
ook Bluetooth en de GPS Location service niet beschikbaar.

De bel uitschakelen
U kunt het belsignaal bij inkomende gesprekken uitschakelen door 
het belprofiel van de handset in te stellen op trillen of op stil (zie 
pagina 34).

Actie 

1 Tik de netwerkindicator ( ) in de statusbalk.

2 Tik in het vak Verbindingsprofiel Aeroplane Mode.
3 Tik OK.

 wordt zichtbaar indien de handset in vliegtuigmodis is.

4 Om terug te keren naar de normale werking, tik op  en 
daarna op Handset On.
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Berichten en e-mail

U kunt e-mails, multimedia- en tekstberichten samenstellen, 
verzenden en ontvangen. 
Om opgeslagen audio-, video-, en fotobestanden met uw e-mails 
en multimediaberichten mee te verzenden, zie �Nieuws en 
entertainment� beginnend op pagina 95.

Instellen van een Messaging-account
Voor u berichten kunt gaan verzenden en ontvangen, 
moet u uw accounts instellen. Neem voor de account-
details contact op met uw serviceprovider.

E-mail
Om e-mails te gaan verzenden en ontvangen, moet u een internet 
account en een e-mail account instellen.
De handset ondersteunt de protocols IMAP4, POP3, en SMTP.
Om een internet-account aan te maken:

Actie 

1 Open het Control panel  in de Application Launcher. 

2 Tik op Connections tabblad > Internet accounts tabblad > Accounts.
3 Tik op New.
4 Voer de informatie in over uw account.
5 Tik op Done.
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Om een e-mailaccount aan te maken:

Multimedia- en tekstberichten
Uw serviceprovider heeft als het goed is al accounts ingesteld voor 
multimedia- en tekstberichten op uw handset.
Om de account-instellingen te controleren,:

Actie 

1 Open het Control panel  in de Application Launcher. 

2 Tik op Connections tabblad > Messaging accounts tabblad > Email.
3 Tik op New. 
4 Voer de informatie in over uw account op de tabbladen Basic, 

Inbox, Outbox, en Advanced.
5 Tik op Done.

Actie 

1 Open het Control panel  in de Application Launcher. 

2 Tik op Connections tabblad > Messaging accounts.
3 Tik op het tabblad Email, Text message, Multimedia message, of, 

indien aanwezig, Info Service om de account-instellingen te 
zien. Tik op de pijlen links en rechts om te schakelen tussen 
de account-tabbladen.
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De Messaging-toepassing openen
Gebruik de Messaging-toepassing om berichten aan te maken, te 
verzenden en te ontvangen.

Berichten opstellen en verzenden

E-mail en tekstberichten

Actie 

Tik op  in de Application 
Selector-balk of de Application 
Launcher. Zodra de Messaging-
toepassing wordt geopend, ziet u 
een lijst van de bestaande 
accounts.
Opmerking: De account slaat de 
gegevens op die ontvangen zijn 
via Bluetooth (zie pagina 70).

Actie 
1 Selecteer e-mail of tekstbericht (sms) in de accounts-lijst.
2 Tik op New.
3 Selecteer desgevraagd Text only, Media only, of Text & media, en 

daarna op Done.

UG.A1000.book  Page 52  Wednesday, May 25, 2005  2:53 PM



Berichten en e-mail - 53

Opmerking: Indien u een videogesprek accepteert terwijl u een 
e-mail of tekstbericht opstelt, wordt het bericht automatisch 
opgeslagen in de Draft-map met e-mails of tekstberichten.

4 In het veld To, vult u het e-mailadres (e-mail) of het 
telefoonnummer (tekstbericht) in van de ontvanger.
Om een adres of telefoonnummer uit het telefoonboek in te 
voeren, tikt u op To.
Om meerdere adressen of telefoonnummers in te voeren, 
plaatst u er telkens een komma tussen.

5 In het veld Subj: (alleen e-mail), vult u een onderwerp in.
6 In het tekstvak schrijft u uw bericht.

7 Om een bijlage aan te hechten, tik op het tabblad   en 
daarna op Add.

8 In het veld Type, selecteert u het bestandstype dat u wilt 
bijvoegen.

9 Tik op het bij te voegen bestand en daarna op Select.
Opmerking: U kunt geen mediabestanden doorsturen die 
daartegen zijn beschermd.

10 Zodra het bericht klaar is, tikt u op Send.

Actie 
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Multimediaberichten
U kunt multimediaberichten aanmaken en verzenden met daarin 
één of meer slides met geluid, video, afbeeldingen en documenten. 

Actie 
1 Tik in de lijst van accounts op de multimediaberichten-

account
2 Tik op New.
3 Tik op Text only, Media only, of Text & media, en daarna op Done.

De eerste slide van het bericht wordt zichtbaar:

Mediagedeelte

Tekstgedeelte

Tijdsduurlabel
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4 Vul het telefoonnummer of het e-mailadres in van de 
ontvanger in het veld To. (De ontvanger moet geabonneerd 
zijn op multimedia-berichten.)
Om een opgeslagen nummer uit uw telefoonboek in te 
voeren, tikt u op To.
Om meerdere telefoonnummers in te voeren, plaatst u er 
telkens een komma tussen.

5 Tik op  om een geluid bij te voegen. U kunt een nieuw 
geluid opnemen of een opgeslagen geluidsbestand 
selecteren.
Aan een multimediabericht kunt u WAV- en AMR-
geluidsbestanden toevoegen.
Opmerking: U kunt geen mediabestanden doorsturen die 
daartegen zijn beschermd.

6 Tik op in het mediagedeelte  om een bestand toe te 
voegen, en selecteer daarna een opgeslagen bestand.
U kunt de volgende types opgeslagen beeldbestanden 
toevoegen aan een multimediabericht: BMP, WBMP, GIF, 
PNG, JPEG, en TIFF.
Opmerking: U kunt geen mediabestanden doorsturen die 
daartegen zijn beschermd.

7 Tik op het tekstvak om de cursor in het tekstvak te plaatsen. 
Voer de tekst in door middel van handschriftherkenning of 
met het virtuele toetsenbord.

Actie 
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Opmerkingen: 
� De grootte van multimediaberichten is beperkt. Indien u deze 

grens overschrijdt, verschijnt er een waarschuwing. Verwijder 
audio- of videobestanden om de grootte van het bestand 
kleiner te maken.

� Indien u een videogesprek accepteert terwijl u een e-mail of 
tekstbericht opstelt, wordt het bericht automatisch opgeslagen 
in de Draft-map met e-mails of tekstberichten.

8 Om de duur van een slide in te stellen, tikt u op het 
tijdsduurlabel ( 10/10s). Geef nu aan hoe lang (in seconden) u 
wilt dat de slide zichtbaar blijft voordat de volgende slide uit 
het bericht automatisch zichtbaar wordt.
Het eerste cijfer van het tijdsduurlabel geeft de duur aan van 
de actuele slide. Het tweede cijfer slaat op de totale duur van 
alle slides in het bericht.

9 Om nog een slide aan het bericht toe te voegen tikt u op .
10 Om de slides te bekijken, tikt u op Play.
11 Zodra het bericht klaar is, tikt u op Send. 

Actie 
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Berichten ontvangen en lezen
Zodra er een nieuw bericht wordt ontvangen wordt een 
berichtindicator zichtbaar in de statusbalk (zie pagina 34).

Actie 
1 Tik op de berichtindicator in de Status balk.

De Messaging-toepassing wordt zichtbaar, met een lijst van 
de bekende accounts. Het aantal ongelezen berichten is 
zichtbaar naast elke account.

2 Tik op de account met het bericht dat u wilt gaan lezen.
Een lijst met berichten wordt zichtbaar. Ongelezen berichten 
staan in vet.

3 Selecteer het bericht dat u wilt lezen.

4 Bijlagen zijn herkenbaar aan een . Tik op een bijlage om 
deze te openen.

UG.A1000.book  Page 57  Wednesday, May 25, 2005  2:53 PM



58 - Telefoonboek

Telefoonboek

Gebruik de telefoonboek-toepassing om gegevens op te slaan 
zoals namen, telefoonnummers en e-mailadressen. U kunt 
contacten in het telefoonboek bellen of een bericht versturen.

De telefoonboek-toepassing openen
Tik op  in de Application Selector-balk of de Application Launcher. 
Er wordt een alfabetische lijst van opgeslagen contacten zichtbaar:

De volgende pictogrammen kunnen zichtbaar zijn naast de naam 
van een contact:

 - Zichtbaar indien er een voicetag is toegewezen aan een 
telefoonnummer (zie pagina 62).

 Zichtbaar indien er een contact is opgeslagen in de USIM-map. 
Om de voorkeurtelefoonnummers naast de contacten weer te geven, 
tikt u op Edit > Preferences en vinkt u Show preferred phone number aan.
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Contacten toevoegen
Actie 
1 Open de map waarin u het contact wilt opslaan. Om het 

contact op te slaan op uw USIM-kaart, opent u de USIM-
map.

2 Tik op Contacts > New om het 
formulier Contactinformatie te 
bekijken.

3 Voer de naam in van het contact, de telefoonnummers, het 
emailadres en desgewenst overige informatie.
Opmerking: Indien u meer dan één telefoonnumer opslaat, 
(bijvoorbeeld, een nummer op het werk en thuis), kunt u 
selecteren welk nummer in de lijst wordt weergegeven als 
voorkeurnummer. Om dat te doen tikt u op Edit > Preferred 
number en selecteert u het voorkeurtelefoonnummer in de lijst.

4 Tik op  voor elk nummer om de communicatiemethode te 
selecteren: Telefoon (landlijn), Mobiel, E-mail, Web, of Web-
call (e-mailadres voor tweetraps gekozen videogesprek).
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5 Om een voice tag op te nemen, zie "Het opnemen van voice 
tags voor contacten" op pagina 62.

6 Om een unieke beltoon aan het contact toe te wijzen, bladert 
u indien nodig naar beneden en tikt u op [Ring tone].

7 Selecteer een toon in de lijst. Bij het ontvangen van een 
voice- of een videogesprek van de desbetreffende contact, 
zal de geselecteerde beltoon hoorbaar worden.

8 Tik op  om de geselecteerde beltoon te horen.

9 Om een nieuw veld aan het contact toe te voegen tikt u op 
Edit > Add field. "Nieuwe velden toevoegen" op pagina 61.
Opmerking: Deze stap is optioneel. De velden moeten 
worden toegevoegd tijdens het invoeren van de informatie 
van het contact. U kunt na het opslaan van het contact geen 
nieuwe velden meer toevoegen. 

10 Om een notitie toe te voegen aan een contact, tikt u op , 
en voert u de notitie in.

11 U kunt een notitie markeren als privé. Privé-notities worden 
niet mee verzonden indien u de contactdetails gaat 
verzenden of synchroniseren.

Actie 
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Nieuwe velden toevoegen

12 Om een foto uit het geheugen aan een contact toe te wijzen, 
tikt u op , daarna , waarna u de foto of de 
afbeelding selecteert.

of 

tik op  om een foto te nemen.
Het beeld, aan een contact toegewezen, word zichtbaar 
wanneer u een contact opbelt, of als u door dat contact wordt 
gebeld.

13 Zodra u alle informatie over een contact heeft ingevoerd, tikt 

u .
Het contact wordt nu zichtbaar in het telefoonboek.

Actie 
1 Tik bij het invoegen van informatie voor een nieuw contact op 

Edit > Add field.
2 Tik op New field: en dan op een veld uit de lijst.
3 Tik op Add.

Het formulier Contactinformatie wordt zichtbaar en (new field) 
is zichtbaar naast het toegevoegde veld.

4 Herhaal deze stappen om nog meer velden toe te voegen.

Actie 
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Het opnemen van voice tags voor contacten
U kunt een voice tag opnemen tijdens het toevoegen van een 
nieuw contact (pagina 59), of tijdens het bewerken van een contact 
(pagina 63).
Opmerking: Het contact moet minstens één telefoonnummer 
hebben waaraan een voice tag kan worden toegewezen.
U kunt een voice tag opnemen voor alle telefoonnumers van een 
contact. Aan elk telefoonnummer moet een unieke voice tag 
toegewezen worden.
Tip: Maak de opname op een rustige plaats. Houd de handset 
ongeveer 10 centimeter van uw mond en spreek met een normale 
stem rechtstreeks in de microfoon van de telefoon. 

Actie 
1 Bij het toevoegen of het wissen van een contact, tikt u op het 

vak Voice Tag onder het telefoonnummer.
2 Zodra daar om wordt gevraagd tikt u op Record en spreekt u 

de gewenste voice tag in.
3 Zodra u daar om wordt gevraagd, tikt u nogmaals op Record 

en herhaalt u de voice tag.
Een vinkje (o) in het vakje Voice Tag geeft aan dat er een voice 
tag is opgenomen.

4 Tik op het veld naast het vakje Voice Tag, en selecteer Voice call 
of Video call.

5 Herhaal deze stappen om nog meer voice tags voor dit 
contact op te nemen.
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Voice tags wissen

Contacten bewerken

Actie 

1 Tik op  in de Application Selector-balk of de Application 
Launcher om uw telefoonboek te openen.

2 Tik op een contact in de lijst.
3 Tik op Edit > Edit contact.
4 Tik op het vakje Voice Tag voor de tag die u wilt wissen.
5 Tik op Yes.

Actie 

1 Tik op  in de Application Selector-balk of de Application 
Launcher om uw telefoonboek te openen.

2 Tik op een contact in de lijst.
3 Tik op Edit > Edit contact.

Opmerking: Uw veranderingen worden automatisch 
opgeslagen.
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Communiceren met contacten
U kunt gemakkelijk bellen, mailen, of berichten verzenden naar de 
contacten in het geheugen.

Actie 
1 In het telefoonboek tikt u op 

de naam van het contact. De 
opgeslagen telefoonnumers 
en e-mailadressen worden 
zichtbaar:
Een telefoonnummer of een 
e-mailadres kan extra 
pictogrammen hebben, 
afhankelijk van de 
geselecteerde 
communicatiemethodes.

2 Tik op het pictogram voor het gesprek of het bericht dat u 
wilt:

of Voice-gesprek naar een telefoon
Video-gesprek naar een telefoon of een computer 

(telefoonnummers)

Video-gesprek naar een computer (e-mailadressen)
E-mail bericht naar een telefoon of computer

Multimediabericht naar een telefoon of computer
Tekstbericht naar een telefoon

UG.A1000.book  Page 64  Wednesday, May 25, 2005  2:53 PM



Telefoonboek - 65

Voice dialling gebruiken
Druk even op a (speakertoets) en 
spreek daarna binnen de 2 seconden 
de opgenomen voice tag in.
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De instellingen van de handset aan 
uw voorkeur aanpassen

Een achtergrondafbeelding instellen
U kunt een afbeelding kiezen, die op de achtergrond van de 
Application Launcher zichtbaar is.

De helderheid van het scherm instellen

Actie 

1 Open de Application Launcher ( ).
2 Tik op View > Wallpaper.
3 Tik op Find image in het veld Background om een opgeslagen 

afbeelding te selecteren.
4 Tik op Done.

Actie 

1 Open het Control panel  in de Application Launcher. 

2 Tik op Screen op het tabblad Handset.
3 Schuif de Brightness-regelaar naar de gewenste instelling.
4 Tik op Done.
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De kalibratie van het scherm instellen

Het volume voor systeemgeluiden instellen
Stel het volumeniveau in van de beltoon, het touchscreen, de 
toetsen en systeemmeldingen, het waarschuwingsprofiel en het 
gespreksvolume.

Actie 

1 Open het Control panel  in de Application Launcher. 
2 Tik op Screen op het tabblad Handset.
3 Tik op Calibrate.
4 Zodra daarom wordt gevraagd tikt u op het midden van de 

punten 1, 2, en 3 om het scherm te kalibreren.
of 

Druk op het midden van S om de kalibratie terug te brengen 
naar de fabrieksinstelling.

of 
Druk op S in om het even welke richting om te annuleren.

5 Tik op Done.

Actie 

1 Open het Control panel  in de Application Launcher. 
2 Tik op Sound op het tabblad Handset.
3 Selecteer de gewenste instellingen voor de beltoon, het 

touchscreen, de toetsen en systeemmeldingen, het 
waarschuwingsprofiel en het gespreksvolume.

4 Tik op Done.
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My shortcut instellen
Druk op de browsertoets L om de Browser te starten, of houdt de 
browsertoets ingedrukt voor My Shortcut. U kunt zelf instellen 
welke toepassing met My Shortcut geopend wordt.

Beltonen kiezen
Als u het waarschuwingsprofiel instelt op Audio, krijgt u een beltoon 
te horen bij inkomende berichten en gesprekken (zie pagina 34).
Aan contacten toegewezen unieke beltonen hebben voorrang op 
de beltonen die u hier selecteert (zie pagina 59).

Beltonen voor inkomende gesprekken kiezen

Actie 

1 Open het Control panel  in de Application Launcher. 
2 Tik op Shortcut key op het tabblad Handset.
3 Selecteer een toepassing in de lijst.
4 Tik op Done.

Actie 

1 Open de telefoon-toepassing ( ).
2 Tik op Settings > Tones.
3 Selecteer de gewenste beltonen voor lijn 1 en lijn 2 (indien 

aanwezig), video, voicemail, en videomail. 

Om de geselecteerde beltoon te horen tikt u op .
4 Kies een instelling voor de Keypad van de telefoontoepassing.
5 Tik op Done.
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Beltonen voor berichten kiezen

Een trilpatroon kiezen
Indien u het waarschuwingsprofiel instelt op trillen, gaat de handset 
trillen om een binnenkomend gesprek of bericht aan te geven. U 
kunt kiezen uit verschillende trilpatronen.
Opmerking: Zie pagina 34 om het waarschuwingsprofiel te 
bekijken en in te stellen.

Actie 

1 Open de Messaging-toepassing ( ).
2 Tik op Edit > Preferences.
3 Selecteer de gewenste beltonen voor elke messaging-account.

Om de geselecteerde beltoon te horen tikt u op .
4 Tik op Done.

Actie 

1 Open het Control panel  in de Application Launcher.
2 Tik op het tabblad General.
3 Tik op Ringtune Manager.
4 Tik op het tabblad Vibrate.
5 Tik op het trilpatroon dat u wilt gaan gebruiken. Om he 

patroon te testen, tikt u op de play-knop onder het 
selectievak.

6 Tik op Done.
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Haal meer uit uw handset

Het installeren van de A1000 Desktop Suite
Belangrijk: Installeer de A1000 Desktop Suite voordat u uw 
handset op een ander apparaat aansluit, zoals een computer of 
een Bluetooth-apparaat. U vindt de A1000 Desktop Suite op de 
meegeleverde cd. De Desktop Suite stelt u in staat om verbinding 
te maken met een computer of Bluetooth-apparaat om:

� de e-mail en de agenda, het telefoonboek en to do-lijsten te 
synchroniseren tussen uw handset en een computer

� reservekopieën te maken en informatie terug te plaatsen 
tussen uw handset en een computer

� bestanden over te zenden tussen uw handset en een 
computer

� Toepassingen te installeren op uw handset

Verbinding maken met een Bluetooth-apparaat
Belangrijk: Voordat u de telefoon aansluit op een Bluetooth-
apparaat, dient u dat apparaat volgens de aanwijzingen in de 
bijbehorende gebruikershandleiding in te stellen. 

Actie 

1 Open het Control panel  in de Application Launcher. 

2 Tik op het tabblad Connections > Bluetooth.
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Uw Bluetooth-instellingen veranderen

3 Tik op het tabblad Devices en daarna op Add.
Uw handset gaat op zoek naar alle apparaten in de 
omgeving waarop Bluetooth actief is.

of 
Tik op Show:, selecteer het gewenste type apparaten en tik op 
Refresh.

4 Tik in de lijst met beschikbare apparaten op het apparaat dat 
u wilt aansluiten.
Voer desgevraagd het wachtwoord in en tik op Done. 
Een wachtwoord is een reeks cijfers en/of letters (van 
minstens vier tekens) dat u afspreekt met de eigenaar van 
het andere apparaat. Zodra het wachtwoord wordt 
geaccepteerd, is het verbindingsproces volledig.

Actie 

1 Open het Control panel  in de Application Launcher.

2 Tik op Connections tabblad > Bluetooth > Settings.
3 Om Bluetooth in te schakelen, tikt u op het vakje naast 

Bluetooth On. Een vinkje in het vakje wijst er op dat de 
hardware is ingeschakeld.

4 Selecteer een instelling bij Visible for other devices:.
5 Selecteer een instelling voor Receiving items: (zie tabel 

hieronder) en voer een Bluetooth-naam in voor uw handset.
6 Tik Done.

Actie 
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Receiving items: deze instellingen bepalen wat uw handset doet 
wanneer informatie van aangesloten Bluetooth-apparaten wordt 
ontvangen.

Aansluiten op een computer
Belangrijk: Voor u uw handset op een computer aansluit, moet de 
A1000 Desktop Suite, op de meegeleverde cd, zijn geïnstalleerd.

Een USB-kabelverbinding instellen
Sluit de USB-kabel aan tussen de accessoire-aansluiting onderaan 
uw handset en de USB-poort van uw computer. 

Om de aansluiting te voltooien tikt u op  (Desktop Suite) in de 
Application Launcher, en tik daarna op Connect.

Een Bluetooth verbinding instellen

Instelling Beschrijving 
Always receive accepteert de informatie
Ask first vraagt u de informatie te accepteren
Never receive weigert de informatie

Actie 
1 Kijk na of uw pc geschikt is voor Bluetooth en zet daarna een 

aansluiting op zoals beschreven op pagina 70.

2 Open het Control panel  in de Application Launcher.

3 Tik op het tabblad Connections > Desktop Suite.
4 Tik in het veld Link using: op Bluetooth.
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De Desktop Suite gebruiken
Start na het aansluiten van uw handset op de computer het A1000 
Desktop Suite-programma op de computer. Zie de A1000 Desktop 
Suite online-hulp voor meer informatie over het gebruik van het 
programma.

Remote Synchronisatie gebruiken
De handset laat toe de agenda, to do-lijsten en contact-informatie 
over the air (OTA) te synchroniseren met een synchronisatieserver. 
De handset is ontworpen om te synchroniseren met de 
basismogelijkheden van de initiële release van van veel Personal 
Information Management (PIM) software- en hardwareproducten. 

Uw account instellen
Om remote synchronisatie te gaan gebruiken, moet u voor het 
opzetten van een account contact opnemen met uw 
serviceprovider. Om via het web te synchroniseren heeft u ook een 
internet-account nodig.

5 Om een Preferred PC te selecteren, tikt u op Change en daarna 
op Done.

6 Om de aansluiting te voltooien tikt u op  (Desktop Suite) in 
de Application Launcher en daarna op Connect.

Actie 
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De instellingen configureren
Zodra u beschikt over uw account-informatie, kunt u de handset 
configureren voor remote synchronisatie.

Picsel Viewer gebruiken
Picsel Viewer herformatteert automatisch veel populaire 
bestandsformaten zoals tekst, presentaties en databeheerformats, 
zodat ze passen op het scherm van uw handset. 

Actie 

1 Tik op SyncML  in de Application Launcher.
2 Tik Edit > Settings.
3 Voer de Server address:, Username, en Password in.
4 Tik op Done.
5 Tik op de taak die u wilt inschakelen.
6 Tik op het vakje Enable task:.
7 Voer de Server database: in.
8 Tik op Done.
9 Tik op Edit > Settings, en daarna het tabblad Protocol.
10 Tik op het vakje Use transport login:.
11 Voer een Username en Password in.
12 Tik op Done.
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U kunt Picsel Viewer gebruiken om documenten te openen, 
waaronder ontvangen berichten, ontvangen documenten en 
documenten van het internet die zijn opgeslagen op uw A1000 
handset of personal computer. Met behulp van de stylus en de 
pictogrammen kunt u deze documenten gemakkelijk openen, 
doorbladeren, er op in zoomen en er doorheen navigeren.

Documenten openen
Actie 

1 Open Picsel Viewer ( ) in de Application Launcher.
2 Zoek het document in de opgeslagen Bookmarks, History -lijst, 

mappen of lijsten.
3 Tik op de naam van het document om het te openen.

Tik op Documents om opties weer te geven en te selecteren 
zoals verzenden, wissen, veranderen van naam, de 
geschiedenis bekijken en bookmarken.
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Navigeren door de documenten
Met de navigatiepictogrammen kunt u gemakkelijk in- en 
uitzoomen, de weergave veranderen en naar andere pagina's van 
het document gaan.

Navigatiepictogram Beschrijving en procedure
Thumbnails weergeven 
( )

Van maximaal 3 pagina's wordt een 
thumbnail getoond. Tik op een 
thumbnail om de pagina te bekijken. 
Tik op de linker pijl om naar de 
eerste pagina te gaan, tik op de 
rechter pijl om naar de laatste pagina 
te gaan. Gebruik de thumbnails om 
te zien welk deel van het document 
wordt weergegeven. Sleep het rode 
vakje over de thumbnail om een 
ander deel te bekijken.

Documentopties

Navigatie
pictogrammen
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Aan de schermbreedte 
aanpassen ( )

Een document weergeven over de 
volledige beschikbare 
schermbreedte.

Aan de paginagrootte 
aanpassen ( )

De volledige pagina weergeven.

Inzoomen ( ) Inzoomen op het document.
Uitzoomen ( ) Uitzoomen op het document.
Weergeven op ware 
grootte ( )

Een document weergeven op 
volledige, originele grootte.

Volledig scherm
profiel ( )

Een document of afbeelding 
weergeven op de volledige, originele 
grootte en de status- en Application 
Selector-balk verbergen.

Scherm roteren ( ) Het scherm 90° roteren. Tik 
nogmaals om terug te keren naar het 
normale scherm.

Terug ( ) Het document verlaten.

Navigatiepictogram Beschrijving en procedure
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Voorkeuren instellen
Actie 
1 Tik op Edit > Preferences.
2 Selecteer in de lijst.

Page flick - ga naar de volgende of de vorige pagina van een 
document door de stylus over de onderkant van het 
document te slepen. Deze functie werkt alleen als de 
thumbnails niet zichtbaar zijn.
� Sleep de stylus naar rechts om naar de vorige pagina 

terug te keren.
� Sleep de stylus naar links om naar de volgende pagina te 

gaan.
Show as pictures - alleen beschikbaar voor HTML- en PDF 
documenten.
Reflow text - het formaat van documenten veranderen zodat 
ze op de breedte van het scherm passen.
Keep for - het aantal dagen selecteren dat documenten 
bewaard moeten blijven voor ze automatisch worden gewist.
Clear history - alle geschiedenisdocumenten wissen.
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Functies van de persoonlijke 
organizer

Agenda 
Gebruik de agenda om gebeurtenissen zoals afspraken en 
vergaderingen te plannen en te ordenen. U kunt het overzicht per 
dag, per week of per maand bekijken. Daarnaast kunt u instellen 
dat de handset een alarmsignaal afspeelt voor bepaalde items.
Opmerking: Zorg er voor dat de juiste datum en tijd zijn ingesteld 
voor u de agenda gaat gebruiken (pagina 86).

Een agenda-item toevoegen
U kunt de volgende types items in de agenda opnemen:

� Appointment - Een item met een start- en einduur (bijvoorbeeld 
een vergadering)

� Reminder - Een item dat niet tijdgebonden is (een verjaardag 
bijvoorbeeld)

� All day event - Een item met een begin- en een einddatum, maar 
zonder specifieke tijd. Gebruik een all day event voor een item 
dat een hele dag of meerdere dagen duurt (een conferentie 
bijvoorbeeld).
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Om een agenda-item toe te voegen:

Actie 

1 Open Agenda  in de Application Launcher.

2 Tik op Calendar > New.
Het Agenda invoerscherm 
wordt zichtbaar.

3 Gebruik de stylus of het virtuele toetsenbord om een 
beschrijving in te vullen.

4 Kies het type item.
5 Voer datum, tijd en locatie van het item in.
6 Tik op het vakje Alarm indien u wilt dat de handset u aan dit 

item herinnert met een geluidssignaal.
De tijd en de datum van het alarm worden zichtbaar onder 
het vakje Alarm. Om het tijdstip waarop het alarm hoorbaar 
wordt te veranderen, tikt u op de tijd of de datum.
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De agendaweergave veranderen
U kunt de agenda op verschillende manieren weergeven: per dag, 
per week of per maand. Als u de agenda opent, verschijnt hij in 
dagweergave.

Om over te schakelen naar weekweergave, tikt u op .

Om over te schakelen naar maandweergave, tikt u op .

Om terug over te schakelen naar dagweergave, tikt u op .
Om terug te keren naar de huidige datum in de gekozen weergave, 
tikt u op .

Om de details van een item te zien, tikt u op het item.

7 Indien dit item een terugkerende gebeurtenis betreft, tikt u op 
Repeat om het herhalingsinterval te selecteren. Vink het vakje 
Forever aan, om het alarm onbeperkt te herhalen.

8 Om dit item te markeren als Privé bij het synchroniseren van 
agenda-items met een computer tikt u op Private.

9 Om een opmerking aan een item toe te voegen, tikt u , en 
voert u de opmerking in.

10 Tik op  om het item op te slaan.

Actie 
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Items verplaatsen naar de To Do-toepassing
U kunt agenda-items verplaatsen naar de To Do-toepassing, 
waarin de taken staan die u moet voltooien.

Opmerkingen: To-Do itmes hebben geen herhalingen, tijd of 
locaties, dus agenda-items die u verplaatst naar To Do-toepassing 
zullen deze informatie verliezen. Indien u een item verplaatst met 
een alarm, zal dat wel te horen blijven op het ingestelde tijdstip.

To Do
Gebruik de To Do-toepassing om taken op te sommen en bij te 
houden die u moet voltooien. Voor een To Do-item kunt u een 
einddatum of een herinneringsalarm instellen en aangeven of de 
taak voltooid is.

Actie 
1 Open het item.
2 Tik op Calendar > Move to To do.
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Items toevoegen:
Actie 

1 Open To do  in de Application Launcher.

2 Tik op To do > New.
Het To Do invoerscherm 
wordt zichtbaar.

3 Gebruik de stylus of het virtuele toetsenbord om een 
beschrijving in te vullen.

4 Selecteer een prioriteit (1-9, met 1 als hoogste) voor de taak.
5 Tik op het vakje Due date indien u deze taak wilt voorzien van 

een einddatum.
De huidige datum is zichtbaar naast het vak Due date. Om een 
andere einddatum te selecteren tikt u op de datum en 
selecteert u een datum in de weergegeven kalender.
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Taken markeren als voltooid
Zodra u To Do opent in de Application Launcher, wordt een lijst van 
taken zichtbaar samen met hun einddatum. 

6 Tik op het vakje Alarm indien u wilt dat de handset u aan dit 
item herinnert met een geluidssignaal. 
De tijd en de datum van het alarm worden zichtbaar onder 
het vakje Alarm. Om het alarm te veranderen tikt u op de tijd of 
de datum.

7 Om dit item te markeren als Privé bij het synchroniseren van 
To Do-items met een computer tikt u op Private.

8 Om een opmerking aan een item toe te voegen, tikt u , en 
voert u de opmerking in.

9 Tik op  om het item op te slaan.

Actie 
Om een taak te markeren als voltooid, tikt u op het vakje ernaast. 
De indicator voor herinneringsalarm verdwijnt, wat er op wijst dat 
de taak voltooid is.
Opmerking: Om voltooide items te verbergen, tikt u op Edit 
> Preferences en daarna verwijdert u het vinkje voor Display 
completed:.

Actie 
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Items verwijderen
Indien u een vermelding voor een voltooide taak niet langer nodig 
heeft, kunt u het verwijderen.

Items verplaatsen naar de agenda
U kunt To Do-items gaan plannen in de agenda door ze naar de 
agenda-toepassing te verplaatsen (pagina 79).

Opmerkingen: Indien u geen einddatum invoert voor het To Do-
item, gebruikt de handset de huidige datum voor het item.
Indien u een item verplaatst met een alarm, zal dat te horen blijven 
op het ingestelde tijdstip.

Actie 
Om een individueel item te verwijderen, tikt u op het item in de 
lijst en daarna op Delete.
Om alle afgewerkte items te verwijderen in uw lijst tikt u op To do 
> Delete completed.

Actie 
1 Open het gegeven.
2 Tik op To do > Move to Calendar.
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Notities
Gebruik Notities om notities en schetsen te maken.

Notities toevoegen

Tijd
Gebruik de Tijd-toepassing om de huidige tijd en datum in te 
stellen. Met de wekker kunt u alarmen instellen die u niet in uw 
Agenda of To Do-lijst wilt opnemen.

Actie 

1 Open Notities ( ) in de Application Launcher.

2 Tik op Notes > New.
3 Voer tekst in met behulp van de stylus of het virtuele 

toetsenbord.

4 Om een schets aan de notitie toe te voegen tikt u op .
5 Gebruik de stylus om de figuur te tekenen.

Gebruik de knoppen onderaan het scherm om de lijndikte en 
-kleur te veranderen, en lijnen te wissen.

6 Tik op  om de notitie op slaan.
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De datum en tijd instellen
Om de huidige tijd en datum in te stellen:

Actie 

1 Open Tijd ( ) in de Application Launcher. De datum en 
tijd worden zichtbaar:

2 Tik op Date & Time > Set time & date.
3 Voer de huidige datum en tijd in.
4 Om het datum- en tijdsformaat in te stellen, tikt u op het 

tabblad Format en selecteert u het formaat in de lijst met 
beschikbare formaten.

5 Tik op Done.

Huidige datum en 
tijd

Andere locatie en 
tijdzone

Alarm-items

Actuele stad
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De locatie instellen
De Tijd-toepassing kan tijds- en datuminformatie weergeven voor 
twee locaties:

� Current - De plaats waar u zich momenteel bevindt. De tijd en 
datum van uw huidige locatie worden zichtbaar in de bovenste 
helft van het scherm.

� Other - Een stad naar keuze. De tijd en de datum van deze 
stad verschijnen onder de tijd en datum van uw huidige 
locatie. Indien u in het buitenland bent, kunt u bijvoorbeeld de 
tijd thuis zien door deze locatie in te stellen op uw woonplaats.

Alarm instellen
In de Tijd-toepassing kunt u alarmen instellen. Dit is ideaal voor 
gebruik als wekker en voor andere regelmatige items die u niet wilt 
opnemen in uw agenda en to do-lijst.

Actie 
1 Tik op Date and Time > Set location.
2 Selecteer uw huidige locatie in de lijsten Current country: en 

Current city:.
Opmerking: Indien de stad van uw keuze niet wordt 
weergegeven, selecteert u dan een andere stad binnen dezelfde 
tijdzone.

3 Selecteer een andere locatie (optioneel) in de lijsten Other 
country: en Other city:.

4 Tik op Done.
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U kunt in de Tijd-toepassing tot drie alarmen instellen. De alarm-
items worden zichtbaar in de onderste helft van het Tijd-scherm.

Reageren op alarm
Zodra een alarm hoorbaar is, verschijnt het geselecteerde bericht. 
Tik op de knop Snooze om het alarm uit te stellen zodat het na 5 
minuten weer hoorbaar is.
Opmerking: Het alarm gaat niet af als u aan het bellen bent of een 
voice-memo opneemt.

Actie 
1 Tik op één van de alarm-items.
2 Stel de volgende alarmdetails in:

Time - tijdstip waarop het alarm moet afgaan.
When: - hoe vaak het alarm moet afgaan. Eén keer, gedurende 
de volgende 24 uren, dagelijks, alleen op werkdagen of 
wekelijks.

Alarm sound: - het geluidssignaal van uw keuze. Tik op  om 
het geselecteerde geluid te horen.
Message - een bericht invoeren of uit de lijst selecteren.

3 Tik op Done.
4 Tik op het vakje alarm om het alarm in te schakelen.
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Een alarm uitschakelen
Om een alarm uit te schakelen voor het afgaat kunt u een van de 
volgende dingen doen:

� Verwijder het vinkje voor het alarm-item.
� Tik op het alarm-item en selecteer Silent in Alarm sound:.

Calculator
Om de Calculator te openen, tikt u op  in de Application 
Launcher.
Gebruik de calculator door te tikken op de toetsen op het scherm. 

Voice-opname maken
Met uw handset kunt u persoonlijke berichten opnemen.
Opmerking: Het opnemen van telefoongesprekken wordt bepaald 
door de wetgeving omtrent privacy en het opnemen van 
telefoongesprekken.
Tip: Maak de opname op een rustige plaats. Houd de handset 
ongeveer 10 centimeter van uw mond en spreek met een normale 
stem rechtstreeks in de microfoon van de telefoon.
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Tip: U kunt het volume bij het terugluisteren aanpassen.

Actie 

1 Open Voice-opname ( ) in 
de Application Launcher.

2 Tik op Voice > New Voice note of 
op New (onderaan het 
scherm).

3 Tik op  om de opname te 
beginnen.

4 Tik op  om de opname te 
beëindigen.

5 Tik op  om de opname te beluisteren.
Een teller bovenaan het scherm geeft het volgnummer van 
de huidige opname, en het totale aantal opnames. 
Bijvoorbeeld, 1 / 2 geeft aan dat u bij de eerste van twee 
opnames bent.

Tik op  om tijdens de weergave te pauzeren.

Tik op  om verder te luisteren.

Schuif  naar links om het volume te verlagen, of naar 
rechts om het volume te verhogen tijdens de weergave.
Om een opname te wissen, tikt u op Delete als de opname 
geopend is.
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Een opname beluisteren

Een opname wissen

Een opname verzenden

Actie 

1 Open Voice-opname ( ) in de Application Launcher.

2 Tik op  of op  om naar de opname te gaan die u 
wilt beluisteren.

3 Tik op  om de opname af te spelen.

Actie 

1 Open Voice-opname ( ) in de Application Launcher.

2 Tik op  of op  om naar de opname te gaan die u 
wilt wissen en tik op Voice > Delete note of op Delete (onderaan 
het scherm).

Actie 

1 Open Voice-opname ( ) in de Application Launcher.

2 Tik op  of op  om naar de opname te gaan die u 
wilt verzenden en tik daarna op Voice > Send as.

3 Tik op één van de opties in het vakje Send as en daarna op 
Done.

4 Volg de normale procedure voor het verzenden.
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Beveiliging

De handset vergrendelen 
en ontgrendelen
U kunt de handset vergrendelen zodat 
het touchscreen en de toetsen niet 
werken. Indien de handset 
vergrendeld is, kunt u nog altijd de 
toetsen B en A gebruiken voor 
binnenkomende oproepen.

Een bescherming met een wachtwoord opzetten
U kunt een beveiliging instellen met een wachtwoord om 
ongeoorloofde toegang tot de informatie in de handset te 
voorkomen.

Actie 

1 Open het Control panel ( ) in de Application Launcher.

2 Op het tabblad Handset, tikt u op Password.
3 Tik op het tabblad Security en daarna op Set Security Code.
4 Tik uw huidige veiligheidscode in en tik daarna op Done.
5 Voer een nieuwe veiligheidscode in en tik daarna op Done.
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6 Om een nieuwe vergrendelingscode voor uw handset in te 
stellen, tikt u op het tabblad Phone Lock > Set lock code. Voer een 
vergrendelingscode in en tik daarna op Done. bevestig de 
vergrendelingscode en tik daarna op Done.
Selecteer On or Off voor Auto Phone Lock:.
Om de code te wissen tikt u op Clear voert u de huidige code 
in en tikt u op Done.

7 Indien u wilt dat het invoerscherm voor het wachtwoord ook 
de eigenaarsinformatie weergeeft: 

a Tik op het tabblad Owner.
b In het vak Owner information: voert u de tekst in die u wilt 

weergeven.
c Tik op Done.

Actie 
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Nieuws en entertainment

Webbrowser
Met de webbrowser kunt u webpagina's openen en 
webtoepassingen (zoals online bankieren, winkelen en 
spelletjes) gebruiken op uw handset. 

Uw internet-account instellen
Voor u gebruik kunt maken van de webbrowser moet u een 
internet-account instellen (zie pagina 50).

De webbrowser openen
Om de webbrowser te openen tikt u ofwel op  in de Application 
Launcher of de Application Selector-balk, of drukt u op L.
Als u bookmarks en/of webpagina's heeft opgeslagen, wordt er een 
alfabetische lijst van bookmarks of opgeslagen pagina's 
weergegeven, afhankelijk van welke lijst u het laatst heeft bekeken.
Opmerking: Indien uw bookmarks of opgeslagen pagina's niet 
zichtbaar worden, tikt u op Browse > Bookmarks of Saved pages. 
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Webpagina's openen

Bookmarks toevoegen
Om een bookmark voor een webpagina toe te voegen zodat u er 
later naar kunt terugkeren zonder het adres in te tikken:

Actie 
Tik op de bookmark of de opgeslagen webpagina die u wilt 
openen.
of
Tik op Browse > Open new. Voer het adres in van de webpagina's in 
het veld Location en tik daarna op Open.
Opmerking: U kunt http:// weglaten.

Actie 
1 Open de webpagina.
2 Tik op Browse > Page information.
3 Tik op Bookmark.

Opmerking: U kunt desgewenst de titel veranderen voor u 
de bookmark opslaat in het veld Title:.

4 Tik op Add.
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Webpagina's opslaan
Om webpagina's op te slaan zodat u ze later kunt bekijken indien er 
geen verbinding meer is met het internet (offline browsen):

Downloaden van audio, video en afbeeldingen
U kunt geluidsbestanden, videoclips, en foto's downloaden van het 
web. Om een bestand te downloaden volgt u de instructies op de 
webpagina. 
Zodra het downloaden klaar is wordt het bestand geopend in de 
browser of in een andere handset-toepassing (afhankelijk van het 
bestandstype). U kunt het bestand opslaan in een map van de 
handset of op de geheugenkaart

U heeft een licentie nodig om mediabestanden te 
openen die digitaal zijn beschermd. Indien u geen 
licentie heeft voor een beschermd bestand zal u 
gevraagd worden de webbrowser te openen en er een te 
downloaden. 

Actie 
1 Open de webpagina.
2 Tik op Browse > Page information.
3 Tik op Save.

Opmerking: U kunt desgewenst de titel veranderen in het 
veld Title: voor u de pagina opslaat.
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Muziek
Gebruik de Muziek-toepassing om te luisteren naar de volgende 
soorten geluidsbestanden: AU, AMR, MIDI, MP3, en WAV. U kunt 
luisteren naar geluidsbestanden die u van het web heeft 
gedownload, bestanden ontvangen als bijlagen bij een e-mail of 
naar bestanden die zijn opgeslagen op een verwisselbare 
geheugenkaart. 

Muziek openen
Tik op  in de Application 
Launcher. Zodra de Muziek-
toepassing opent, ziet u een lijst 
met alle opgeslagen 
muziekbestanden.
Om de geluidsbestanden in een 
specifieke map te bekijken, tikt u op 
de huidige mapnaam (rechter 
bovenhoek) en selecteert u de 
gewenste map in de lijst.
Op de met de handset 
meegeleverde cd staan enkele 
voorbeelden van muziekbestanden.

U heeft een licentie nodig 
om mediabestanden te openen die digitaal zijn 
beschermd. Indien u geen licentie heeft voor een 
beschermd bestand zal u gevraagd worden de 
webbrowser te openen en er een te downloaden. 
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Opmerking: Geluidsbestanden moeten worden opgeslagen in de 
juiste directory op de geheugenkaart om ze te kunnen bekijken en 
weergeven in de Muziek-toepassing. Indien u geluidsbestanden 
kopieert van een computer naar de geheugenkaart, moet u er voor 
zorgen dat deze bestanden zijn opgeslagen in een derde niveau-
directory onder: Media Files\Audio\
U kunt bijvoorbeeld geluidsbestanden opslaan in één van de 
volgende directories:
Media Files\Audio\Classical
Media Files\Audio\Rock
Media Files\Audio\Unfiled

Een geluidsbestand afspelen
Actie 
1 Tik in de lijst met bestanden op het bestand dat u wilt 

beluisteren.
Informatie over het bestand (artiest, album, enz.) wordt 
zichtbaar en het bestand wordt afgespeeld.
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2 Terwijl het bestand wordt afgespeeld, kunt u op de volgende 
knoppen onderaan het scherm tikken:

 Tikken om het vorige bestand in de lijst af te spelen. 
Ingedrukt houden om terug te spoelen.

 Tikken om de weergave te stoppen en terug te keren 
naar het begin van de track.

  Tikken om te pauzeren en verder af te 
spelen.

 Tikken om het volgende bestand in de lijst af te spelen. 
Ingedrukt houden om verder te spoelen.

Opmerking: Met de toets S kunt u ook door de bestanden 
navigeren: omhoog = vorig bestand, omlaag = volgend bestand, 
midden = spelen/pauze.

Actie 
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Een playlist maken
De Muziek-toepassing kan alle tracks in een map weergeven in 
een door u aangegeven volgorde. Om de volgorde te specificeren, 
moet u de playlist van de map bewerken:

Actie 
1 Open de map met de tracks die u wilt weergeven.

2 Tik op  om over te schakelen naar de Playlist-weergave.
3 Tik op Edit > Edit Playlist. Het 

Edit Playlist-scherm wordt 
zichtbaar:

4 Om de volgorde te regelen, tikt u op een track en daarna op 
de pijlen om deze naar boven of naar beneden te bewegen 
binnen de lijst.

5 Zodra de tracks in de gewenste volgorde staan, tikt u op Done.
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Een Music Playlist weergeven

Audiobestanden opslaan
Zodra u een audiobestand heeft gedownload van het web of een 
geluidsbijlage bij een e-mail opent, wordt het scherm Save Audio File 
zichtbaar. Om het bestand op te slaan in een map van de handset 
of op de geheugenkaart:

Actie 
1 Open de gewenste map.

2 Tik op  om over te 
schakelen naar de Playlist-
weergave

3 Tik op  om de 
gemarkeerde track weer te 
geven

of 
Selecteer een track door 
deze aan te tikken. Het 
afspelen start automatisch.
De Muziek-toepassing speelt de tracks in de geselecteerde 
volgorde.

Actie 
1 Tik op de pijl naar benden links van de bestandsnaam.

Het scherm File information wordt zichtbaar.
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Opmerking: Om optimaal gebruik te kunnen maken van het 
geheugen van de handset, slaat u indien mogelijk de 
geluidsbestanden op op de geheugenkaart.

2 Tik op het scherm Audio op  om het geluidsbestand te 
beluisteren, of op de rechter pijl om het te installeren als 
beltoon.

3 Tik op Save.
4 Selecteer de plaats waar u het bestand wilt gaan opslaan.
5 Tik op Save.

Actie 
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Camera 
U kunt gebruik maken van de ingebouwde camera om foto's te 
maken en videoclips op te nemen.

De Camera-toepassing openen
Tik op  in de Application Launcher. Zodra de Camera-
toepassing opent, ziet u een beeldzoeker met het beeld van de 
cameralens.

Beeldzoeker

Foto/video-selectie

Beschikbaar geheugen
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De voorste en de achterste camera 
U kunt gebruik maken van voorste en de achterste lens. Om van 
camera te wisselen tikt u op .

De insteltoetsen van de camera gebruiken
U kunt uw handset op dezelfde manier als een gewone camera 
houden om opnames te maken. Houdt de handset horizontaal met 
uw rechterwijsvinger op de cameratoets terwijl u op het scherm 
kijkt. In het cameraprofiel worden de volumetoetsen gebruikt om in- 
en uit te zoomen.
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Foto's maken

De camera-instellingen wijzigen
U kunt de afmetingen van de foto, de kwaliteit, de verlichting, en de 
flikkercorrectie van de camera aanpassen.

Actie 

1 Tik op  om de fotocamera te selecteren.

2 Richt de cameralens op het onderwerp.

3 Tik op  of druk op de cameratoets of op C 
(middentoets) om de foto te maken.
De foto verschijnt in de beeldzoeker.

4 Tik op  of druk op de cameratoets of op C 
(middentoets) om de foto op te slaan.
Om een foto te wissen zonder hem op te slaan, drukt u C 
(rechter pijl) of tikt u op . 

Actie 

1 Tik op  om de fotocamera te selecteren.

2 Tik op Camera > Camera settings.
3 Selecteer de gewenste instellingen.
4 Tik op Done.

UG.A1000.book  Page 106  Wednesday, May 25, 2005  2:53 PM



Nieuws en entertainment - 107

Videoclips opnemen
U kunt de camera gebruiken om een videoclip van maximaal 60 
seconden op te nemen.

De zelfontspanner gebruiken
De camera heeft een zelfontspanner die automatisch na 5 
seconden een foto maakt of een videoclip opneemt.

Actie 

1 Tik op  om de videocamera te selecteren.
2 Richt de cameralens op het onderwerp.
3 Druk op C (middentoets) en houd deze 2 seconden 

ingedrukt om de video-opname te starten.
De videobeeld verschijnt in de beeldzoeker.

4 Om de opname te stoppen, drukt u nogmaals C 
(middentoets).
De video wordt opgeslagen in de momenteel geselecteerde 
mappen. 
Opmerking: U kunt in plaats van de navigatietoets ook de 
cameratoets of de stylus gebruiken voor de bediening van de 
videocamera.

Actie 
1 Stel de camera in op foto of video.
2 Tik op Camera > Self timer on.
3 Richt de cameralens op het onderwerp.
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Indicatie beschikbaar geheugen
Het weergegeven aantal Pictures of Clips onder de beeldzoeker 
geeft een indicatie van het aantal foto's of videoclips dat u kunt 
maken voordat de geheugenruimte van de geselecteerde map vol 
is. Zodra het geheugen vol is, stopt de camera met opnemen.

Overschakelen naar Pictures
Wanneer de fotocamera is geselecteerd, kunt u snel overschakelen 
naar Pictures om de gemaakte foto's te bekijken, te bewerken of te 
verzenden. Zie "Foto's" op pagina 113.

Tik op  om naar Pictures te gaan. 

Overschakelen naar Video
Wanneer de videocamera is geselecteerd, kunt u snel 
overschakelen naar Video om de gemaakte video's te bekijken of te 
verzenden. Zie �Video� verderop.

Tik op  om naar Video te gaan. 

Video
Gebruik de Video-toepassing om videoclips te bekijken of 
Quickplay video en audio van het web weer te geven. U kunt kijken 
naar videoclips die u zelf heeft opgenomen, gedownload van het 
web, ontvangen als bijlage bij een e-mail of naar clips die zijn 
opgeslagen op een verwisselbare geheugenkaart.

4 Druk op C (middentoets) om de zelfontspanner te starten.
De camera start met aftellen van 5 tot 0. Na 5 seconden 
wordt er een foto genomen of start het opnemen van de 
videoclip.

Actie 
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Video openen
Tik op  in de Application Launcher. Zodra de Video-toepassing 
opent, ziet u een lijst met alle opgeslagen videoclips.
Om de videobestanden in een specifieke map te bekijken, tikt u op 
de huidige mapnaam (rechter bovenhoek) en selecteert u de 
gewenste map in de lijst.
Op de met de handset meegeleverde cd staan enkele voorbeelden 
van videobestanden.

U heeft een licentie nodig om mediabestanden te 
openen die digitaal zijn beschermd. Indien u geen 
licentie heeft voor een beschermd bestand zal u 
gevraagd worden de webbrowser te openen en er een te 
downloaden. 

Opmerking: Videobestanden moeten worden opgeslagen in de 
juiste directory op de geheugenkaart om ze te kunnen bekijken en 
weergeven in de Video-toepassing. Indien u videobestanden 
kopieert van een computer naar de geheugenkaart, moet u er voor 
zorgen dat deze bestanden zijn opgeslagen in een derde niveau-
directory onder:
Media Files\Audio\
U kunt bijvoorbeeld videobestanden opslaan in één van de 
volgende directories:
Media Files\Video\Movie Trailers
Media Files\Video\Home
Media Files\Video\Unfiled
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Een videoclip afspelen
Actie 
1 Tik in de lijst met bestanden 

op de clip die u wilt 
weergeven.
De video begint af te spelen 
in portretweergave 
(verticaal):
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Om de video te bekijken in landschapsmodus (volledig scherm), tikt 
u op het videoscherm. Om terug te keren naar portretweergave, tikt 
u nogmaals op de weergegeven video.

Quickplay video en audio weergeven
Om Quickplay video en audio van het web weer te geven, gebruikt 
u de webbrowser om de link naar de video, het geluid of de 
uitzending te selecteren. De handset maakt verbinding met de 
server, en de voorbereiding begint. Zodra de voorbereidingen klaar 
zijn, wordt de video of het geluidsbestand weergegeven.

2 Terwijl de video wordt weergegeven, kunt u op de volgende 
knoppen onderaan het scherm tikken:

  Tikken om te pauzeren en verder af te 
spelen.

 Tikken om de video te stoppen en terug te keren naar 
het begin.

 Tikken om de videocamera te starten.

 Tikken om terug te keren naar de lijst met clips.

Opmerking: Met de toets C kunt u ook door de bestanden 
navigeren: links = terugspoelen naar het begin van de clip, 
midden = play/pauze.

Actie 
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Videoclips opslaan
Zodra u begint met het downloaden van een videoclip van het web 
of het openen van een video e-mailbijlage, begint de weergave van 
de clip in de Video-toepassing. U kunt de clip opslaan in een map 
van de handset of op de geheugenkaart

Opmerking: Om optimaal gebruik te kunnen maken van het 
geheugen van de handset, slaat u indien mogelijk de 
videobestanden op op de geheugenkaart.

Videoclips verzenden
U kunt videobestanden verzenden via e-mail, tekstberichten, 
multimedia-berichten of Bluetooth.
Opmerking: Zie voor nadere informatie over Bluetooth pagina 70.

Actie 
1 Tik op Video > Save.
2 Selecteer de plaats waar u het bestand wilt opslaan.
3 Tik op Save.

Actie 
1 Tik in de lijst met videoclips op de clip die u wilt verzenden.
2 Tik op Video > Send as.
3 Selecteer de werkwijze waarop u de videoclip wilt verzenden.
4 Tik op Done.
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Foto's
Gebruik de Foto-toepassing om fotobestanden te bekijken en te 
bewerken. U kunt kijken naar foto's die u zelf heeft opgenomen, 
gedownload van het web, ontvangen als bijlage bij een e-mail of 
naar afbeeldingen die zijn opgeslagen op een verwisselbare 
geheugenkaart. 

Foto's openen
Tik op  in de Application Launcher. Zodra Pictures opent, ziet u 
thumbnails van alle opgeslagen fotobestanden of een lijst van 
fotobestanden (afhankelijk van de laatst geselecteerde weergave).
Om de fotobestanden in een lijst te bekijken, tikt u op Setting > List.
Om de foto's in een specifieke map te bekijken, tikt u op de huidige 
mapnaam en selecteert u de gewenste map in de lijst.
Opmerking: De foto's moeten worden opgeslagen in de juiste 
directory op de geheugenkaart om ze te kunnen bekijken in de 
Foto-toepassing. Indien u fotobestanden kopieert van een 
computer naar de geheugenkaart, moet u er voor zorgen dat deze 
bestanden zijn opgeslagen in een derde niveau-directory onder:
Media Files\Image\
U kunt bijvoorbeeld foto's opslaan in één van de volgende 
directories:
Media Files\Image\Kids
Media Files\Image\Vacation
Media Files\Image\Unfiled
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Afbeeldingen bekijken
Actie 
1 Tik op de thumbnail of de 

naam van het bestand dat u 
wilt bekijken. De foto wordt 
weergegeven.
Indien de originele foto 
groter is dan het 
schermoppervlak, wordt hij 
verkleind tot hij past. Om de 
foto in zijn originele grootte 
te zien, tik op Pictures > Actual 
size view. Gebruik C 
(midden) om de foto te 
verplaatsen.

2 Terwijl de foto wordt weergegeven kunt u op de volgende 
knoppen onderaan het scherm tikken:

 Tikken om de vorige foto te zien.

 Tikken om de volgende foto te zien.

 Tikken om de fotocamera te openen.

 Tikken om terug te keren naar de fotolijst.
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Een diashow bekijken
U kunt alle foto's in een map bekijken als een diashow.

Foto's bewerken
U kunt de Foto-toepassing gebruiken om foto's te bewerken op de 
volgende manieren:

� Beeld roteren
� Op een foto tekenen
� Een plaatje toevoegen aan een foto
� Een lijst toevoegen aan een foto

Om een foto te bewerken, selecteert u de gewenste functie in het 
menu Edit.

Actie 
1 Open de map met de foto's die u wilt bekijken.
2 Tik op Pictures > View slideshow.

De foto's in de map worden achtereenvolgens weergegeven.
Opmerking: Het standaard interval tussen twee dia's is 
3 seconden. Om dit interval te veranderen, tikt u op Setting 
> Slideshow interval voor u de diashow start. 
Indien u het Manual profiel selecteert, moet u links en rechts S 
drukken om de diashow te doorlopen.
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Foto's verzenden
U kunt foto's verzenden via e-mail, tekstberichten, multimedia-
berichten of Bluetooth.

SIM-toepassingen (SimApps)
De USIM-kaart kan toepassingen bevatten waarmee u 
uitgaande gesprekken, SMS-berichten en andere 
services kunt verwerken. Neem voor meer informatie 

contact op met uw serviceprovider.

Actie 
1 Tik op de thumbnail of de naam van het bestand dat u wilt 

verzenden.
2 Tik op Pictures > Send as.
3 Selecteer de wijze waarop u de foto wilt gaan verzenden.
4 Tik op Done.

Actie 

Tik op SimApps ( ) in de 
Application Launcher.
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Gegevens omtrent specifiek 
absorptieniveau

Dit model telefoon voldoet aan de internationale normen voor 
blootstelling aan radiogolven.
Uw mobiele telefoon is een radiozender en -ontvanger. Het toestel 
is zodanig ontworpen en vervaardigd dat wordt voldaan aan de 
grenswaarden voor blootstelling aan radiofrequente straling. Deze 
grenswaarden maken deel uit van uitgebreide richtlijnen waarbij de 
toegelaten niveaus van radiofrequente straling zijn vastgesteld 
voor de bevolking in het algemeen. De richtlijnen zijn gebaseerd op 
normen die onafhankelijke wetenschappelijke organisaties hebben 
ontwikkeld door periodieke en grondige evaluatie van 
wetenschappelijke studies. De richtlijnen omvatten een aanzienlijke 
veiligheidsmarge om de veiligheid van alle personen, ongeacht hun 
gezondheid of leeftijd, te waarborgen.
Voor de blootstellingsnorm van mobiele telefoons gaat men uit van 
een maateenheid die bekend staat als Specific Absorption Rate 
(�SAR�), d.w.z. specifiek absorptieniveau. Volgens de richtlijnen is 
de SAR-grens voor uw model telefoon 2.0 W/kg.1 De tests voor de 
SAR worden uitgevoerd in overeenstemming met de 
testprocedures van CENELEC2, met gebruikmaking van standaard 
bedieningsplaatsen terwijl de telefoon op alle geteste 
frequentiebanden uitzendt tegen het hoogst toegestane 
vermogensniveau. Hoewel de SAR wordt bepaald op het hoogst 
toegestane vermogensniveau, kan de werkelijke SAR van de 
telefoon tijdens de werking aanzienlijk beneden de 
maximumwaarde liggen. Dit komt doordat het telefoonontwerp is 
gericht op werking bij verschillende vermogensniveaus om slechts 
het voor het bereiken van het netwerk benodigde vermogen te 
gebruiken. In het algemeen is de vermogensafgifte van de telefoon 
lager naarmate u dichter bij het basisstation bent.
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Voordat een telefoonmodel verkrijgbaar is voor het publiek, wordt 
door tests gecontroleerd of het aan de richtlijnen voldoet. De tests 
worden uitgevoerd in posities volgens een uniforme testmethode 
die wordt vastgesteld door een deskundig normalisatie-instituut. De 
hoogste SAR-waarde voor dit model telefoon bij de test voor 
gebruik bij het oor is: 0.74 W/kg.3

Hoewel de SAR-niveaus van verschillende telefoons en in 
verschillende posities kunnen verschillen, voldoen zij allemaal aan 
de overheidsvereisten inzake veilige blootstelling. 
N.B. Verbeteringen van dit model kunnen leiden tot verschillende 
SAR-waarden bij latere producten; producten zijn in alle gevallen 
zodanig ontworpen dat zij voldoen aan de richtlijnen.

1 De volgens internationale richtlijnen aanbevolen SAR-grens (van de ICNIRP) voor 
door het publiek gebruikte mobiele telefoons bedraagt gemiddeld 2.0 Watt/kilogram 
(W/kg) per tien gram weefsel. Deze grens omvat een aanzienlijke veiligheidsmarge 
teneinde bijkomende bescherming te bieden aan het publiek en rekening te houden 
met eventuele afwijkingen bij metingen.

2 CENELEC is een Europees normalisatie-instituut. 
3 Aanvullende relevante informatie, waaronder het Motorola testprotocol, de 

evaluatieprocedure en meting van de onzekerheidsmarge voor dit product.
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Index

A
A1000 desktop suite  70

aansluiten op een computer  
72

plaatsen  26
aan/uit

in- en uitschakelen  26
toets  26

accessoires  19
accounts

e-mail  51
multimediabericht  51
SMS  51

achtergrond  66
afspelen

geluidsbestanden  99
videoclips  110

afspraken  79
agenda  79

alarm, instellen  80
een gegeven toevoegen  79
items verplaatsen naar to do  

82
soorten items  79
terugkerende items  81
weergave  81

alarmen
agenda  80
geluid uitschakelen  90
instellen  88
reageren op  89
to do  84

alarmnummer bellen  47
Application  29
application launcher  31
Application Selector-balk  29
AU-bestanden  98
audioprofiel-indicator  34

B
basisscherm

weergeven  40
batterij

levensduur verlengen  23
opladen  25
plaatsen  24
sterkte-indicator  36

batterij opladen
snellader  25

batterijdeksel
vervangen  25
verwijderen  21

bellen  27
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tonen kiezen  68
uitschakelen  49

beltonen
kiezen voor berichten  69
kiezen voor inkomende 

gesprekken  68
toewijzen aan contacten  60

berichten
accounts  50
beltonen  69
bijlagen openen  57
ontvangen  57
statusbalkindicator  35
toepassing openen  52
trilpatroon  69
verzenden  52

beschikbaar geheugen, camera  
108

bestanden
audio opslaan  102
bijlages aan e-mail en 

tekstberichten  53
downloaden vanaf het web  

97
een multimediabericht 

toevoegen  55
verzenden  112, 116
video opslaan  112

bijlagen, openen  57
Bluetooth  72

statusbalk  35
bookmark

openen  96
toevoegen  96

Browser-toets  30

C
calculator  90
camera

foto's maken  106
geheugen, beschikbaar  108
instellingen  106
insteltoetsen  105
landschapsweergave  111
lens vooraan en achteraan  

105
portretweergave  111
toepassing openen  104
zelfontspanner  107

computer
verbinden met  72

contact velden
nieuwe toevoegen  61

contacten
bellen  64
beltoon, toewijzen  60
berichten verzenden naar  

64
foto's, toewijzen  61
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opslaan op de USIM-kaart  
59

toepassing openen  58
toevoegen  59
velden  61
voorkeur-telefoonnummer  

58

D
dagweergave  81
datagesprek

draadloze verbinding  72
desktop suite

plaatsen  26
diashow  115
downloaden

bestanden  97

E
e-mail

account  51
bijlagen openen  57
ontvangen  57
statusbalkindicator  35
verzenden  52
verzenden naar een contact  

64

F
foto's

diashow  115
foto's bekijken  114
maken met de camera  106
toepassing openen  113
toewijzen aan contacten  61
weergeven  114

G
geheugenkaart

geluidsbestanden opslaan 
op de  102

plaatsen  22
videobestanden opslaan op 

de  112
geluiden, systeem  67
gesprek

video  44
gesprekken

alarmnummer bellen  47
beantwoorden  28, 48
bellen  27
beltonen  68
naar opgeslagen contacten  

64
nummer vormen met het 

toetsenbord  44
spraak  44
trilpatroon  69
video  44
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gesprekken beantwoorden  28, 
48

gewone gesprekken  44
GPRS  36
GPS  35, 49
GSM  36

H
handset

display toetsenbord  42
draadloze verbinding  72
gesprekken beantwoorden  

28, 48
nummer vormen met het 

toetsenbord  44
statusbalkindicator  35
toepassing openen  42
uw eigen telefoonnummer 

weergeven  43
videogesprekken voeren  44
vliegtuigprofiel  49
voice-bellen  27, 44

handset ontgrendelen  93
handset vergrendelen  93
helderheid

scherm  66
herinneringen  79
herkenning handschrift  37

I
informatie snacks  41
ingebouwde speaker  43
inhoud verpakking  19
internet

openen van webpagina's  96

K
kiezen

met het toetsenbord  44
opgeslagen nummers  44, 64

klok  34
knoppenbalk  29

L
landschapsweergave  111
locatie, tijdzone  88
locatieservice

in- en uitschakelen  35
statusbalkindicator  35

luidspreker
gebruiken  43
in-/uitschakelen  43
volume aanpassen  43

M
maandweergave  81
mappen  33
mappen toevoegen  34
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menubalk  29
MIDI-bestanden  98
MP3-bestanden  98
multimediabericht

maximale grootte  56
ontvangen  57
statusbalkindicator  35
verzenden  54

muziek
bestanden afspelen  99
bestanden opslaan  102
ondersteunde bestandstypes  

98
openen  98
playlists beheren  101
playlists weergeven  102

N
navigatietoets  30
netwerk

statusbalkindicator  36
notities

notities maken  86
schetsen maken  86

O
opnemen

videoclips  107
opnemen van voice tags  62
opslaan

audiobestanden  102
e-mailadres  59
telefoonnummers  59
videobestanden  112

optionele accessoires, 
gedefinieerde  20

optionele functies, 
gedefinieerde  20

P
persoonlijke informatie  41
Picsel Viewer  98
pictogrammen

statusbalk  34
toepassingen  32

plaatsen
batterij  24
geheugenkaart  22
USIM-kaart  20

portretweergave  111
privé

agenda-items  81
to do-items  84

Q
quickplay video  111

R
roaming

statusbalkindicator  36
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Ruimte Application  29

S
scherm

achtergrond  66
beschrijving  29
helderheid  66
kalibratie  67

scherm kalibreren  26
schetsen  86
schrijven

met de stylus  37
virtueel toetsenbord 

gebruiken  38
shortcut

toepassing instellen  68
signaal uitgeschakeld

statusbalkindicator  35
signaalsterkte, indicator  36
SIM-kaart. Zie USIM-kaart
sim-toepassingen  116
SMS  50

ontvangen  57
statusbalkindicator  35
verzenden  52

snacks  41
speltoetsen  31
startscherm

personaliseren  41
statusbalk  29, 34

stil profiel-indicator  34
stylus  30
systeemgeluiden  67

T
taal

selecteren  26
tekstinvoer  37
telefoonnummer

nummer vormen met het 
toetsenbord  44

opslaan in telefoonboek  59
uw eigen telefoonnummer 

zien  43
tijd

alarmen  88
to do

alarm  84
einddata  83
items toevoegen  83
items verplaatsen naar de 

agenda  85
items verwijderen  85
taken markeren als voltooid  

84
toepassing

openen  31
pictogrammen  32
shortcuts  41

toetsen

UG.A1000.book  Page 124  Wednesday, May 25, 2005  2:53 PM



Index - 125

camera  105
Driehoek  30
luidspreker  43
navigatie  30
selecteren  30
spel  31
Voeding  26
volume  43

toetsenbord
gebruiken  38
launcher  34

touchscreen  30
trilpatroon  69
trilprofiel

in- en uitschakelen  35
indicator  34

U
UMTS  36
USIM-kaart

contacten opslaan op  59
plaatsen  20

V
van map veranderen  33
veiligheid

handset vergrendelen  93
wachtwoordbescherming  93

verwijderen
mappen  34

verzenden
berichten  52
foto's  116
videoclips  112

video
bestanden opslaan  112
clips verzenden  112
clips weergeven  110
toepassing openen  109

videoclips
afspelen  110

videogesprekken
computers bellen  46
nummer vormen met het 

toetsenbord  45
virtuele toetsenbord  38
vliegtuigprofiel

in- en uitschakelen  36, 49
statusbalkindicator  36

voice tags
opnemen  62

voicebericht, indicator  35
voice-opname  90

verwijderen  92
verzenden  92
weergeven  92

volume
aanpassen  43
toets  43
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W
waarschuwingsprofiel  34

statusbalkindicator  34
wijzigen  34

wachtwoord.
het beschermingsniveau 

instellen  93
WAV-bestanden  98
web

bestanden downloaden  97
bezochte pagina's opslaan  

97
bookmarks opslaan  97
openen van pagina's  96

weekweergave  81
WMA-bestanden  98

Z
zelfontspanner, camera  107
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